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Introducing Xnews
Xnews is a MOS-compliant Newsroom Computer System (NRCS) plug-in that provides news 
producers and journalists with immediate access to images, graphic elements and 
templates directly from their newsroom desktops. Graphic pages can be created or edited 
to produce effective lower-thirds, over-the-shoulder graphics images, and full-screen builds 
with animated highlights. Finished graphic pages can then be quickly dragged and 
dropped into local news rundowns, which can then be played out using Xplay.

Xnews is available as an ActiveX plug-in or a stand-alone web client. As an ActiveX plug-in 
software, Xnews integrates fully into the following MOS compliant newsroom systems:

Newsroom Computer Systems
• ENPS from Associated Press 
• iNEWS from Avid
• Inception News from Ross Video
• Octopus NRCS

In The newsroom workflow with the Vertigo Suite, on page 2, you will find conceptual 
information on how Xnews and the Vertigo Suite integrate and operate within typical 
newsroom environments.

Further chapters in this user manual provide practical information and instructions for 
installing and integrating Xnews into your newsroom computer system client workstation, 
as well as how to use Xnews to create, edit, and playout graphics pages and rundowns.

• Installing Xnews on your NRCS Client Workstation, on page 5
• Familiarizing yourself with the Xnews Interface, on page 21
• Preparing to use Xnews, on page 43
• Embedded Pages: Creating, editing and previewing, on page 49
• Shared Pages: Creating, editing and previewing, on page 65
• Clip Assets: Opening and editing the Mark In/Out settings, on page 77
• Creating and working with stories and rundowns in ENPS, on page 85
• Creating and working with stories in INEWS, on page 91
• Playing out rundowns using Xplay, on page 95

Note: Since Xnews is a plug-in that integrates into third-party 
newsroom computer systems, we limit our documentation coverage 
to topics related to the operation and integration of Xnews. We 
strongly recommend that you refer to your NRCS’s user 
documentation for instructions and information relating to using a 
newsroom computer system. 
 1
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The newsroom workflow with the Vertigo Suite
Integrating the Vertigo Suite into your existing newsroom environment improves the 
efficiency of your entire newsroom workflow. Graphic artists use Xstudio to create 
templates for news graphics that are then stored on an Xmedia Server archive. These 
templates are accessible to all the networked newsroom computer system (NRCS) 
workstations used by graphics artists and journalists. 

Since Xnews is integrated into the NRCS workstation interface as a plug-in application, 
journalists can use Xnews to open Vertigo Suite templates and media libraries (i.e. images, 
clips... etc.) to create the news graphics pages that they need to support a story. Once 
completed, the journalist can simply drag-and-drop the graphics page into stories and 
rundowns within the same newsroom system interface. 

Fig. 1-1: Components of the Vertigo Suite integrate with existing newsroom computer systems

When journalists require a graphic element that does not already exist in the system, they 
can use the Vertigo Suite’s Work Order Management system to create a request from the Art 
department and insert a placeholder on their page. Once the graphic artist has created the 
desired graphic element, the journalist can review/approve/reject it, then automatically 
replace the placeholder on the graphics page with the new graphic element.

NRCS Workstations NRCS Server

Xnews

VxWOM

MOS Gateway

MOS Plug-in

Work Order Management

Vertigo Suite environment

Newsroom environment

Xstudio
Template Designer

Xplay
Playout Control Device

Xmedia Server
Graphics Asset Management
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Using the MOS protocol, the newsroom computer system and the Vertigo Suite (i.e. Xmedia 
Server and Xnews) are able to communicate the status of the graphics pages in the 
rundowns, report errors, and recall the pages and their graphic elements. For news 
Directors, the seamless integration of the Vertigo Suite with existing newsroom systems 
facilitates the timing and organization of stories within the rundown, especially last minute 
changes to the rundown. This template-based approach also means that graphics can be 
created at high speed for breaking news.

With the Vertigo Suite integrated into an existing newsroom system, Xplay can be used to 
control the playout of rundowns to output devices. Rundowns are stored on the Xmedia 
Server and are easily loaded into Xplay as playlists. The most common way to control a 
playlist is to advance through the items in order. Last minute changes to graphics can be 
made on the fly, and even if the playlist has been changed by another user on a different 
workstation, the latest version can still be quickly and easily accessed at any time.
3
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Installing Xnews on your NRCS Client 
Workstation
Xnews integrates into newsroom computer systems as an ActiveX plug-in. As such, Xnews 
can be installed directly on workstation computers that run client versions of the 
newsroom control system application.

The following sections provide information and instructions for installing and configuring 
Xnews:

• Prerequisites for installing Xnews on a NRCS client workstation, on page 6
• Step 1: Installing Xnews on a NRCS client workstation, on page 7
• Step 2: Configuring the xnews.ini file, on page 8
• Step 3: Launching Xnews in your NRCS workspace, on page 11
• Step 4: Configuring the Xnews settings, on page 13

Note: Since Xnews is a plug-in that integrates into third-party 
newsroom computer systems, we limit our documentation coverage 
to topics related to the operation and integration of Xnews. We 
strongly recommend that you refer to your NRCS’s user 
documentation for instructions and information relating to using a 
newsroom computer system. 
 5
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Prerequisites for installing Xnews on a NRCS client workstation
Before installing Xnews on a client workstation, your system administrators must complete 
the following system-level tasks:

• Adding and configuring the Xmedia Server as a MOS device, on page 6
• Adding Xnews licenses, on page 6
• Verifying NRCS client workstation requirements, on page 7

Adding and configuring the Xmedia Server as a MOS device
A qualified network or newsroom system administrator must perform the following 
system-level integration tasks in your newsroom computer system and the Vertigo Xmedia 
Server. 

1 Add the Xmedia Server as a MOS device in your newsroom computer system’s 
configuration.

2 Use the Xmedia Server Control Panel to enable and configure the Vertigo Xmedia 
Server as a MOS Server device.

We recommend that the administrator consult the NRCS’s user documentation for 
specific instructions on how to add a new MOS device to the NRCS’s configuration. 
Generally, the information required is:

• MOS ID: This value is case sensitive and must match the MOS ID specified on the 
Xmedia Server’s MOS page in the Xmedia Server Control Panel. The recommended 
format is <family>.<machine>.<location>.<enterprise>.mos.

• HOST / IP: The IP address or host name of the Xmedia Server.
• MOS Version: The version of the MOS protocol that will be used. 

We also recommend that the administrator consults the “Configuring the Xmedia Server a a 
MOS server” section of the Xmedia Server Configuration Guide for instructions on enabling 
the Xmedia Server as a MOS server device.

Adding Xnews licenses
Xnews requires that a valid software license be installed and available for each seat of 
Xnews. System administrators should consult the “Vertigo License Management” section of 
the Xmedia Server Configuration Guide for information and instructions on installing Xnews 
licenses on the Xmedia Server.

As a licensed software application, Xnews checks the Xmedia Server upon startup for a 
valid Xnews license. If a license has been installed and is available, Xnews opens normally 
and is ready for use. However, if a license has not been installed or there are none currently 
available, Xnews displays an error message.

As the license error message states, it might just be a case that your system has limited 
number of floating licenses and that none are currently available. In such a case, you must 
wait until one becomes available before you will be able to use Xnews.

If however you suspect that the Xnews license was not installed on the Xmedia Server, or if 
you suspect that something is wrong with the license (i.e. expired); we encourage you to 
contact your network or newsroom system administrator. The administrator will be able to 
open the Vertigo Suite License Manager to add or verify the Xnews license.
6
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Verifying NRCS client workstation requirements
System administrators should ensure that the client workstations that will run Xnews 
conform to the following hardware and software requirements:

Recommended platform:
• Intel® Core™ i3, i5 or i7 series or Xeon 1.8 GHz or faster
• 4 GB RAM
• 40 GB free hard drive space
• 100/1000 NIC
• 256 MB Nvidia/ATI video card
• Windows XP professional SP3 or Windows 7
• Microsoft Internet Explorer 7.0 or later

Step 1: Installing Xnews on a NRCS client workstation
Before installing Xnews on a NRCS client workstation

1 Ensure that the Xmedia Server is installed and configured (if unsure, consult your 
network administrator).
The Xmedia Server runs the Vertigo Suite of products. It determines the directory paths 
for the templates and pages. It also coordinates the licenses for the system, controls the 
locations to which users working with the client components can publish image files, 
and establishes a connection with the Media Object Server.

2 Ensure with your network administrator that sufficient Xnews licenses are available. 
This should have been done when setting up the Xmedia Server. If not, your network 
administrator must obtain the Machine ID of the Xmedia Server. Then contact Technical 
Support (support@grassvalley.com) to verify your licensing purchase agreement.

3 Find out the IP address and port number of the computer on which the Xmedia 
Server is installed (you will need this information when you first launch Xnews after 
installation).

To install Xnews:
1 Log on with administrator privileges (consult your network administrator for details).
2 Open the Grass Valley Web site in an Internet browser.
3 Navigate to the Software Downloads page (Support > Downloads).
4 Click Downloads for Broadcast Products.
5 Select Vertigo Suite from the drop-down list and click Go.

Or,
Scroll down to the Playout > Graphics category and select Vertigo Suite.

6 Again select Vertigo Suite from the Product Software Download List.
7 Save a local copy of the executable file by right-clicking the appropriate Installer link 

and selecting Save target as.
8 Right-click the Installer file and select Run as Administrator to launch the Vertigo 

XmediaSuite Setup Wizard.
7
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Enabling the Playout Preview setting
9 Follow the Setup Wizard’s initial on-screen instructions, including accepting the License 
Agreement and specifying the Destination Location.

10 In the Select Components window, select Xnews from the drop-down list and click 
Next. 

11 Continue to follow the Setup Wizard’s initial on-screen instructions and restart the 
computer when prompted.

12 Once restarted, the Setup Wizard automatically returns to verify and complete the 
installation process.

Step 2: Configuring the xnews.ini file
Most of the Xnews settings are configured using the Settings window in the Xnews 
application. However, there are four very important scenarios in which you must configure 
settings in the xnews.ini file.

The following sections introduce to you the scenarios that require you to edit the 
xnews.ini file:

• Enabling the Playout Preview setting, on page 8
• Enabling Embedded Pages or Shared Pages mode, on page 9
• Enabling Privates Pages mode, on page 10
• Editing the MOS version for iNEWS, on page 11

Enabling the Playout Preview setting
While editing or creating of a page, Xnews allows you to preview the on-air playout 
appearance and behavior of the page on a designated device (e.g. Software CG).

For the preview page functionality to be used, you must enable the Playout settings in the 
Xnews.ini file and the device must be exclusively available for Xnews connectivity. 

Once these conditions are met, each time a page or template is opened in the Xnews Home 
Area, the Preview page button  appears in the toolbar allowing you to preview the page 
on the device. 

The following procedure provides instructions for enabling the Playout Preview mode in 
the xnews.ini file, while Previewing the on-air look of a page locally, on page 61 provides 
you with information for how to use the Preview Page feature.

To enable the Xnews Preview Page feature:
1 Ensure that Xnews is closed on the NRCS workstation.
2 Verify that a playout device is properly configured in the Vertigo Suite’s Device 

Manager/Configuration (i.e. Xplorer, Xstudio, Xbuilder, or Xplay).
3 Set the Playout settings in the Xnews.ini file.

a Open the Xnews.ini file by navigating to and opening the xnews.ini file: 
C:\ProgramData\VertigoXmedia\Settings\xnews.ini

b Type the device’s name after the PreviewDeviceName= setting.
c Edit the EnablePreview= setting from False to True.
d Save the edits by selecting the File>Save menu command.
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e Close the xnews.ini file.

Enabling Embedded Pages or Shared Pages mode
By default, Xnews is configured to run in Embedded Pages mode, which only allows you to 
create embedded pages. This configuration is preferred in most cases since pages are 
usually created for a specific story or rundown and then they are no longer needed. If your 
intention is to create embedded pages, then you do not have to edit the 
EnableEmbeddedPages setting in the xnews.ini file.

If however, you want to save and re-use the same page(s) in several rundowns, then you 
must configure Xnews for Shared Pages mode. In Shared Pages mode, pages are created 
and then saved on the Xmedia Server as a Page asset. This type of page is often referred to 
as a shared page because it can be used by multiple stories and/or rundowns.

The following procedures describes how to configure Xnews to run in shared page mode, 
as well as how to revert Xnews back to Embedded Pages mode.

To configure Xnews to run in Shared Page mode:
1 Ensure that Xnews is closed on the NRCS workstation.
2 Open the Xnews.ini file by navigating to the following folder and opening the 

xnews.ini file: 
C:\ProgramData\VertigoXmedia\Settings

3 In the [Preferences] section, set EnableEmbeddedPages= to False.
This setting allows you to save the page as a shared page (an asset) on the Xmedia 
Server.

4 Set the [Quiet Mode] parameter: 
• If you want to specify a name and category for the page, set the UseQuietMode2= 

to False. This allows the Save Page window to appear when you attempt to save 
the page. 

Or, 
• If you want the shared page’s name and category assignment to be identical in the 

Pages category to how it was in the Templates root category, set the 
UseQuietMode2= to True.

5 Save and close the xnews.ini file.

To revert Xnews back to embedded mode:
1 Ensure that Xnews is closed on the NRCS workstation.
2 Open the Xnews.ini file by navigating to the following folder and opening the 

xnews.ini file: 
C:\ProgramData\VertigoXmedia\Settings

3 In the [Preferences] section, set EnableEmbeddedPages= to True.

Note: The Enable Private Pages setting in the xnews.ini file 
supersedes the Enable Embedded Pages setting. As such, to create 
embedded pages you must ensure that the Enable Private Pages 
setting is either not present in the xnews.ini file, or that 
EnablePrivatePages=false.
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This setting allows you to save the page as a embedded page in a story.
4 In the [Quiet Mode]section, set the UseQuietMode2= to True. This setting ensures that 

the embedded page’s name is automatically assigned when it is inserted into a story.
5 Save and close the xnews.ini file.

Enabling Privates Pages mode
To create Private pages in Xnews, you must first enable the Private Pages setting in the 
xnews.ini file. You must also set the Expiry settings for Private Pages in the MOS options 
on the Xmedia Server Properties window.

Once these settings are properly set, dragging a template and inserting it into a story in 
Xnews will create a private page.

To configure Private pages in the xnews.ini file:
1 Ensure that Xnews is closed on the NRCS workstation.
2 Open the Xnews.ini file by navigating to the following folder and opening the 

xnews.ini file: 
C:\ProgramData\VertigoXmedia\Settings

3 In the [Preferences] section, set EnablePrivatePages= to True
4 Save and close the xnews.ini file.

To set the Private Page Expiry settings:
1 Open the Xmedia Server Properties window (XMS Panel).
2 Select the MOS tab.
3 In the MOS Options, drop-down list, select Private Pages.
4 In the Unreferenced Private Page Expiry setting, enter a value to represent the 

number of days after which an unused private page is to be removed from the Xmedia 
Server. The default value is 30 days.
A private page is considered to be no longer in use if it is not referenced by any 
rundown in the Xmedia Server. This can occur when a page is deleted from a rundown, 
floated or its rundown is made MOS Control Inactive. If the Private page is restored 
before the expiry deadline, then it will not be removed from the Xmedia Server.
Each time a private page is edited in Xnews, a new private page is created. If the old 
private page is not bound to any other segments when the story is saved to the Xmedia 
Server, then the old private page will have its expiry date set to the current time plus 
the value of Unreferenced Private Page Expiry.

5 In the Temporary Private Page Expiry setting, enter a value to represent the number of 
days after which an unsaved Private page is to be removed from the Xmedia Server. The 
default value is 1 day.
Temporary Private pages refer to Private pages that were created in Xnews, but never 
saved to a rundown on the Xmedia Server. For example, if a page is added to a story, 
but the story is never added to a rundown, then the contained page is considered 
temporary and it will be removed as specified by this setting.

6 Click OK.
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Editing the MOS version for iNEWS
If you are using Xnews within a iNEWS system, you must apply the following edits to the 
Xnews.ini file’s settings.

[Preferences]

DisableSaveAndClose=True

HideSaveAndInsert=True

[MOS]

MOS_Version=2.6

These changes are necessary since iNEWS uses MOS version 2.6, rather than version 2.8 
(default). As a consequence, both the Save and Insert Page button  and the Save button 

 are disabled since they send MOS 2.8 commands.

With these buttons disabled, you can still save a new page by dragging it into the rundown. 
Or, use the Apply button that appears in iNEWS itself, just below the Xnews window, which 
will insert the page (MOS item) back into the story after having edited it.

Step 3: Launching Xnews in your NRCS workspace
You can launch the Xnews application as an ActiveX panel within supported MOS 
compliant Newsroom Computer Systems (NRCS) such as ENPS, iNEWS, Octopus or 
Inception.

The first time you start Xnews after an installation, a red status bar appears in the Xnews 
window and displays an error message that Xnews is unable to connect to the Xmedia 
Server. In fact, every time Xnews is started, it quickly checks for a connection to the Xmedia 
Server, as well as the availability of a valid license. 

If Xnews is not able to connect to the Xmedia Server, the red status bar appears and you 
must verify and/or set the Server settings before you can proceed (see Servers settings, on 
page 13). If after verifying the Server settings, the connection to the Xmedia Server is still 
not established, the problem could be due to one of the following:

• The IP address or port was entered incorrectly.
• The machine hosting the Xmedia Server is down.
• The Xmedia Server is not running on the host machine.
• The machine is not connected to the network.

If a valid Xnews software license is not detected, an error message appears and you should 
consult your system administrator (see Adding Xnews licenses, on page 6).

Launching Xnews in ENPS
To launch Xnews within the ENPS workspace:

1 Launch and log on to your ENPS client using the ENPS workstation’s Start menu or 
desktop shortcut. 

Note: The Xnews stand-alone web client can be accessed via the Vertigo 
folder in the Windows Start > Programs menu.
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2 Right-click the MOS button  and select your MOS ID description name from the 
list.

3 Xnews immediately starts loading into one of the Editing panels on the ENPS interface. 

Launching Xnews in iNEWS
To launch Xnews within the iNEWS workspace:

1 Launch iNEWS using the iNEWS workstation’s Start menu or desktop shortcut.
The iNEWS Server Connection window appears.

2 Log into the iNEWS workstation.
3 Close the iNEWS Messages of the Day window.

The iNews workstation window appears.
4 Launch Xnews by selecting Tools>Plugins>VertigoXmedia Xnews from the iNEWS 

menu bar.
Xnews opens in one of the iNEWS workspace’s panels.

Launching Xnews in Inception
To launch Xnews within the Inception workspace:

1 Launch Inception using the workstation’s Start menu or desktop shortcut.
2 Log into the Inception workstation.
3 In the Tools section of the toolbar, click the MOS Plugins button .
4 From the list, select the name of the MOS Device that represents Vertigo Xnews.

Xnews opens in one of the Inception workspace’s panels.

Note:The MOS ID description name was specified when the ENPS 
MOS configuration settings were specified. You can verify the MOS ID 
description name by selecting the ENPS folder rover > System 
Maintenance > MOS Configuration. The correct Description name is 
specified for the IP address of the ENPS workstation.
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Step 4: Configuring the Xnews settings
Xnews settings are accessed by right-clicking in the Drag bar (1) or the Status bar (2) and 
selecting the Change Settings command.

Fig. 2-1: There are two ways to access the Change Settings command

The Change Settings command opens the Settings window. Selecting a setting category 
from the list in the left-hand portion of the Settings window displays the settings for the 
category.

The following sections provide detailed information about each of the Xnews settings:
• Servers settings, on page 13
• Backup Server settings, on page 14
• Preferences settings, on page 14
• Defaults settings, on page 16
• MOS settings, on page 17
• Spell Check settings, on page 18

Servers settings
As a client application, Xnews must be connected to the Xmedia Server in order to be able 
to access templates and pages stored on the network. It must also be connected to the 
Data Server in order to access the data specified by the templates. The information entered 
in the Server settings tells Xnews which machines hosts the servers.

When Xnews is initially launched the Server tab is the first one displayed. Xnews cannot run 
until key information is provided here.

The following settings must be specified on the Server settings tab:

XmediaServer
• Hostname / IP - The hostname or IP address of the machine hosting the Xmedia Server.
• Port - The port number on which the connection to the Xmedia Server is established. 

Normally the XMS port value is 14050.

1
2
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Data Server
• Hostname / IP - The hostname or IP address of the machine hosting the Data Server.
• Port - The port number on which the connection to the Data Server is established. 

Normally the DataServer port value is 14060.

Backup Server settings
By specifying the Backup Server settings, Xnews is able to seemlessly connect to the 
secondary server’s XMS service and Data Server in the event that the primary Xmedia 
Server unexpectedly goes down.

The following settings must be specified on the Backup Server settings tab: 

Backup XmediaServer
• Hostname / IP Address - Specifies the backup server’s IP address used in case of failure 

of the primary Xmedia Server.
• Port - Specifies the backup server’s port used in case of failure of the primary Xmedia 

Server.

Backup DataServer
• Backup Data Server Hostname / IP Address - Specifies the backup data server’s IP 

address used in case of failure of the primary data server.
• Backup Data Server Port - Specifies the backup data server’s port used in case of failure 

of the primary data server.

Preferences settings
The Preferences page contains settings that allow you to determine some of the behavior 
and appearance defaults for the Asset Gallery, Asset Browser, and Work Order Management 
system in Xnews.

• User interface options
• Automatic behavior options
• Work Order Options

User interface options 
• Startup view - This setting allows you to specify the default view for the Xnews Asset 

Gallery. When Proxy View is selected, the contents of the Pages and Templates root 
categories are displayed in the Asset Gallery as thumbnail images. When Detail View is 
selected, the contents of the Pages and Templates root categories are displayed in the 
Asset Gallery as a list of the assets’ basic properties. See Changing the view style (Detail 
or Proxy), on page 29 for more information.

Automatic behavior options
• Allow Creation of Server Pages - This setting is a mechanism for granting or restricting 

permission for users to create and save new shared pages to the Xmedia Server. See 
Allow Creation of Server Pages, on page 31 for more information.
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• Allow Edit of Server Pages - This setting is a mechanism for granting or restricting 
permission for users to edit shared pages that are stored on the Xmedia Server. 

• Hide the Asset Browser on open - When this setting is enabled, the Asset Browser will 
collapse (hide) when a page or template is opened. See Opening/hiding the Asset 
Browser panel, on page 25 for instructions on how to reopen the Asset Browser once it 
is hidden. When this setting is disabled, the Asset Browser remains open when a page 
or template is opened in the Home Area.

• Preserve Edits on New Page - Creates a new page based on a page that was just edited 
and inserted into a story. Its functionality only applies to new pages created using the 
following methods: 

• holding down SHIFT and dragging the page into a story 
or, 

• holding down SHIFT and clicking the SAVE-AND-INSERT button.
Enabling the PRESERVE EDITS ON NEW PAGE setting and using one of the Shift 
sequences (listed above), creates a new page that is identical to the page just dragged 
out, including all edits that were made to the previous page. The practical use of this 
feature is that the new page remains open in Xnews’ Home Area and is available for 
editing starting from the previous page rather than the template.
Disabling the PRESERVE EDITS ON NEW PAGE setting and using one of the Shift 
sequences (listed above), creates a new page that is identical to the template on which 
it is based, discarding all edits that were made in the previous page.

Work Order Options
• Must have one job - When this setting is enabled, the first job is automatically created 

when the new work order is requested. Enable this setting, as well as the Close on save 
new work order setting (see below), when you want to be able to quickly create work 
orders containing only one job.
Disable this setting, as well as the Close on save new work order setting, if you want to 
use automatic job creation through auto-create-job assets, and create work orders with 
multiple jobs.
Note that for changes to this setting to take effect, Xnews must be restarted.

• Close on save new work order - When this setting is enabled, the Work Order window 
closes when the work order is saved. When this setting is disabled the Work Order 
Window remains open after the work order has been saved.

• Printer - This setting allows you to specify a default printer to which work orders will be 
printed when the Print Work Order button  is selected from the Work Order 
window.

• Number of rows in job list - This setting determines the number of rows that are 
always visible in the job list portion of the Work Order window. Since most work orders 
contain a small number of jobs, the default value of 3 is reasonable. If there are more 
than three jobs in the work order, you can always scroll down through the list to view 
the additional jobs. If you routinely add numerous jobs to a work order, this setting can 
be set to a larger number so that you can see all the jobs without having to scroll. Note 
that the minimum permitted value is 3 and the maximum permitted value is 10.
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Fig. 2-2: The Work Order Options settings affect the features/behavior of the Work Order window

Defaults settings
The Defaults page contains settings that allow you to specify some of the properties and 
storage locations that will be used as the defaults for the Rundowns, Pages, and Place 
Holder created or saved in Xnews.

• Rundown default settings
• Pages default settings
• Placeholder categories default settings

Rundown default settings
• Category - Enter the name of the category into which all rundowns will be stored by 

default on the Xmedia Server. Note that the MOS Control Active setting must be 
enabled when the rundown is created.

• Offset - Enter the default amount of time delay (in seconds) between the playout of 
two consecutive story elements in the rundown.

Pages default settings
• Author Name - Enter the name that will appear by default as the creator of all new 

pages.
• Category - Enter the name of the category into which all shared pages will be stored by 

default on the Xmedia Server.
• Life Span - All pages have an expiry date. Once reached, expired pages are deleted 

from the system in order to keep the server from becoming clogged with pages that 
are no longer relevant. Use this field to enter the number of days before a page expires. 
If left at 0, the page never expires. If an existing page is edited, its expiry date is reset to 
the number of days specified in this field. 

Remove Job Button

Number of rows in job list

Print Work Order buttonSave Work Order Button
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Placeholder categories default settings
• Images - Specifies the category in which new image place holders are saved. If 

unspecified, image place holders are saved to in the same category as the image from 
which the place holder is created. Click the Browse button  to open the Select 
Category window, which allows you to navigate to the desired category location. Then 
click OK to automatically set the selected category as the default.

• Clips - Specifies the category in which new clip place holders are saved. If unspecified, 
clip place holders are saved to the same category as the clip from which the place 
holder is created. Click the Browse button  to open the Select Category window, 
which allows you to navigate to the desired category location. Then click OK to 
automatically set the selected category as the default.

MOS settings
To integrate the Xmedia Server (XMS) into a newsroom environment, the Xmedia Server 
must be configured as a MOS Server and then associated with a Newsroom Computer 
System, like ENPS, iNews or Octopus.

The following MOS settings are used for setting up the connection between Xnews and the 
Media Object Server. Contact your system administrator for the NRCS and MOS IDs.

• Newsroom Computer System ID - Enter the name of the server hosting your 
newsroom computer system. This value must be type in all uppercase characters. Not 
supplying a Newsroom Computer System ID will remove the NRCSID tag altogether.

• Media Object Server ID - All MOS messages to and from the Xmedia Server will be 
identified by the MOS ID assigned by your system administrator (e.g. VERTIGO). This 
value must be type in all uppercase characters. Not supplying a MOS ID will result in the 
Xmedia Server hostname being used as the Media Object Server ID.

• TV Format - The video format that is being used by the Xmedia Server. Valid values are:

• Write item comment - When enabled and a page is saved, the <itemComment> MOS 
tag is written to the MOS XML. The <itemComment> contains the name of the page 
and some MOS clients (i.e. iNEWS) display this information in the rundown.
If the setting is disabled (default), the <itemComment> MOS tag is not written to the 
MOS XML when a page is saved.

• NTSC • HDTV_1080_30M

• PAL • HDTV_1080_25

• HDTV_720_60 • ITV

• HDTV_720_60M • NTSC_16_9

• HDTV_720_50 • PAL_16_9

• HDTV_1080_30
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Spell Check settings
Xnews offers an optional spell check utility, which helps you to avoid any typing error or 
spelling mistakes by underlining any potentially misspelled words that you have entered 
into text boxes on a page. 

• Use spellchecker - When selected, the application helps you to avoid any typing errors 
or spelling mistakes by underlining any potentially misspelled words that you have 
entered.

• Highlight color - Specifies the RGB color that the spell check on setting uses for the 
line color to identify potentially misspelled words.

Logging settings
Xnews’ Logging settings allow you to specify the categories of events that you want to be 
recorded in the Xnews log files, as well as the maximum number and size of Xnews log files 
that will be archived. 

As Xnews operates, events are recorded to a log text file, which is stored under the 
Windows system directory for application specific data.

Since the log files thoroughly track and record Xnews’ events during operation, they are a 
great tool to use for diagnosing error conditions or unexpected behaviors. In fact, our 
Technical Support team will often ask its customers to send them the Xnews log file to help 
them troubleshoot any unexpected behavior that you may be experiencing. 

• Log Level - This sets the default log level used by all logging categories except those 
that have been checked in the Debug Categories list. The choices are:

• Error - Only log errors and essential operations.
• Warn - Log unsuccessful operations that may indicate a problem (in addition to all 

messages logged at the Error level).
• Info - (Default) Log important events that occur during normal conditions (in 

addition to all messages logged at the Warn level).
It is recommended to set the Log Level to Info in order to provide enough information 
in the logs to diagnose common problems without affecting performance.

• Max File Size - Sets the maximum memory size for each log file created per run. The 
default value is 6 MB.

• Max File Count - Specifies the maximum number of Xnews*.log files that will be 
stored. A large enough number should be chosen to store over a day's worth of logs. 
This way if a problem happens the relevant log files will be available. Once the 
maximum number of files is reached, the oldest log file will be replaced by a new one. 
The default value is 5.

• Debug Categories - Select the types of debug logging (categories) that you would like 
to record in the Xnews log file:

• General - General logging that does not fit under any other category.
• Actions - Logs the execution of actions in a panel, template or page.
• Spellcheck - Logs activity in the spell checker.
• DeviceComm - Logs socket communication between the client application and the 

CG as well as server-side socket communications in device drivers. Formerly 
controlled via the VXLOG_DEVICE environment variable set to ‘1’.
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• DeviceComm Verbose - Logs socket communication between the client 
application and the CG as well as server-side socket communications in device 
drivers. Logging with this category is very verbose, since it includes the actual 
bytes that are transmitted. Formerly controlled via the VXLOG_DEVICE 
environment variable set to ‘2’.

• DSClient - Logs client-side socket communication with the Data Server.
• VxmsApi - Logs client-side calls to the Xmedia Server.
• VxmsTcp - Logs client-side socket communication with the Xmedia Server using 

the principal Xmedia Server connection.
• VxmsCache - Logs client-side activity in the Xmedia Server cache.
• VxmsTcpLayer - Logs client-side socket communication with the Xmedia Server 

used by the cache and publishing.
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Familiarizing yourself with the Xnews 
Interface 
The Xnews user interface opens as a panel/workspace in your newsroom computer 
system’s (NRCS) client workstation interface. The Xnews user interface contains its own 
components and features that you will use in the creation and insertion of pages into news 
rundown. 

The following sections provide functional descriptions of the Xnews interface and all of its 
components:

• Overview of the Xnews interface, on page 22
• Toolbar buttons on the Xnews interface, on page 23
• Using the Asset Browser in Xnews, on page 25
• Asset Gallery, Home Area and Status bar, on page 29
• Using the Drag bar to create embedded pages and clips, on page 33
• Searching for assets on the Xmedia Server, on page 34
• Creating and using Work Orders, on page 35
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Overview of the Xnews interface
If you are launching Xnews from your newsroom computer system for the first time, you 
must configure the server settings before you can access the Xnews interface. 

Once you launch Xnews, the Xnews interface appears in a section of your NRCS interface.

Fig. 3-1: Xnews interface with the Asset Browser and Asset Gallery open

Fig. 3-2: Xnews interface with the a page open in the Home Area

1 Toolbar: Contains buttons for creating a new page, saving, and switching between 
Detail and Proxy view in the Asset Gallery. When a template or page is open in the 
Home Area, three additional buttons appear in the toolbar allowing you to save the 
asset and preview the page. See Toolbar buttons on the Xnews interface, on page 23 
for a functional description of each button in the toolbar.

2 Asset Browser: Provides a tree view of the Xmedia Server root categories that contain 
the templates, pages and clips, Work Orders and Jobs. When you click on a folder in the 
Asset Browser, its contents are displayed in the Asset Gallery on the right. You can 
display or hide the Asset Browser by clicking the orange gripper bar. See Using the 
Asset Browser in Xnews, on page 25 for more detailed instructions for using the Asset 
Browser.

3 Asset Gallery / Home Area: When you click a folder in the Asset Browser, its contents 
are displayed in the Asset Gallery in either Detail or Proxy view (to toggle between 
views, click  in the toolbar). Double-clicking a template or page in the Asset Gallery 
opens the template/page in what now becomes the Home Area. You can modify the 
template/page’s editable components in the Home Area and then save the page. If 
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Xnews experienced an error when loading the template or page, a message will appear 
in a banner along the bottom of the Home Area. See Asset Gallery, Home Area and 
Status bar, on page 29 for instructions on how to use the Asset Gallery and Home Area.

4 Status bar: Located next to the toolbar, the Status bar provides the name, source, 
offset, and duration values for the template or page that is currently open in the Home 
Area. Right-clicking the Status bar also provides access to the Change Settings and 
About commands. See Asset Gallery, Home Area and Status bar, on page 29 for 
instructions on how to use the Status bar features.

5 Drag bar: The Drag bar, identified by the Vertigo Xmedia logo, allows you to drag and 
drop the currently open page into the host news system. Right-clicking the Drag bar 
also provides access to the Change Settings command. See Using the Drag bar to 
create embedded pages and clips, on page 33 for instructions on how to use the Drag 
bar.

6 Error Message: Whenever Xnews encounters an error, a red bar appears in the lower 
portion of the Xnews interface that displays an error message describing the source 
and/or consequence of the error. Simply click the error message bar to hide it.

Toolbar buttons on the Xnews interface
The Xnews toolbar contains iconic buttons that execute various Xnews functions. The 
following table provides a brief functional descriptions of each button in the toolbar.

 
Create new

If a page is already open in the Home Area, clicking this button closes the 
page. The Home Area is replaced with the Asset Gallery, which displays the 
contents of the category that was last selected.

 or 
Save page

These buttons only appear in the toolbar when a page/template is open in 
the Home Area. 
When an unsaved page is open in the Home Area, clicking the Save Page 
button  allows you to save the page as a shared page by specifying the 
page details (i.e. name) and the category location(s). 
When a page is open in the Home Area, the Save Page button  appears 
in the toolbar. Clicking this button saves any edits that were made to the 
page. 

 
Save and insert page

This button only appears in the toolbar when a page/template is open in 
the Home Area. 
Allows you to save the open page by adding it to the open story/rundown. 

 
Change the view

Pressing this button toggles the Asset Gallery’s display format between 
Detail and Proxy views. As described on page 29, Detail view displays 
category contents in a list format, which provides more detail about the 
page. While Proxy view displays the pages and templates as thumbnail 
images for quick and easy recognition.

 
Search

Pressing the Search button opens the Search XMS window, which allows 
you to create and execute a search for assets on the Xmedia Server. From 
the search results, you can replace an existing image, cel animation or clip 
asset on a page in Xnews; or open a specific Page, Template, Work Order or 
Job. See Searching for assets on the Xmedia Server, on page 34.
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New Work Order

Pressing this button opens the Work Order window, which allows you to 
create a work order request for the creation or addition of an asset (i.e. 
image) that is needed for a page. Once a work order is created, a 
placeholder is placed on the page. See Creating and using Work Orders, on 
page 35 for more information.

 or 
Preview page

These buttons only appear in the toolbar when a page/template is open in 
the Home Area and the Playout settings are enabled in the xnews.ini file.
Pressing this button publishes the open page to a designated device, which 
allows the page’s on-air likeness to be previewed on the playout device. See 
Previewing the on-air look of a page locally, on page 61 for more 
information.
If the Preview Page button has an X on it, this indicates that Xnews was 
unable to connect to the device. 

 
Remote Preview

This buttons only appears in the toolbar when a page/template is open in 
the Home Area, a Remote Renderer device is defined in the system’s Device 
Manager and Xnews is able to connect to the device.
Pressing this button publishes the open page to the Remote Renderer 
device, which allows the page’s on-air likeness to be rendered and 
previewed as an image on that device. See Creating a Remote Preview of a 
page, on page 62 for more information 

 
Search AP Graphics 
Bank

This button only appears in the toolbar when the Graphics Bank enabled 
setting is selected on the Xmedia Server Control Panel’s Graphics Bank 
page.
Opens the AP Graphics Bank Search window, which allows you to search 
and preview images from the AP Graphics Bank. See for more information.

 
Purchase Graphics 
Bank Images

This button only appears in the toolbar when the Graphics Bank enabled 
setting is selected on the Xmedia Server Control Panel’s Graphics Bank 
page.
Clicking this button while a page is open that contains a preview image 
from the AP Graphics Bank (it has not yet been purchased), opens the AP 
Graphics Bank: Purchase Images window. This window lists the images 
on the page that have yet to be purchased and provides the ability to 
purchase them. See for more information.
Clicking this button while a page is not open or if the page does not 
contain unpurchased images results in an error message. 

 
In Place Pan/Zoom

This button only appears in the toolbar when the page’s Template contains 
more than one Texture object (image object) and the objects’ Allow In 
Place Pan/Zoom property was set to True in Xstudio. See Using In Place 
Image Edit mode to zoom and pan a page’s image, on page 59 for related 
information.
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Using the Asset Browser in Xnews
The Asset Browser is a collapsible panel on the left-side of the Xnews interface that allows 
you to view and access the pages, templates, and clips that are stored on the Xmedia 
Server. As well, the Asset Browser allows you to access the Work Orders and Jobs that are 
also stored on the Xmedia Server.

The Asset Browser organizes pages, templates, and clips in a tree structure of root 
categories and subcategories, which can be navigated by expanding or collapsing the 
category. Note that you can create new subcategories, but the root categories are 
permanent and subcategories cannot be deleted in Xnews. When a category is selected, 
the pages, templates, or clips of the category are listed/previewed in the Asset Gallery (to 
the right of the Asset Browser).

Fig. 3-3: The Asset Browser in Xnews

In addition to accessing the contents of the Xmedia Server, the Asset Gallery has a context 
menu that features a series of commands that are used to perform various tasks using the 
selected asset category.

The following sections provide instructions for using the Asset Browser in Xnews to 
manage and organize the pages and templates stored on the Xmedia Server:

• Opening/hiding the Asset Browser panel, on page 25
• Refreshing a category, on page 26
• Adding a new category, on page 26
• Setting access permissions for an asset category, on page 27

Opening/hiding the Asset Browser panel
The Asset Browser is a collapsible browser that is located and anchored to the left side of 
the Xnews interface. By collapsible, we mean that you open and hide the browser’s display 
by clicking the gripper bar on the left-hand side of the screen (Figure 3-4).

Note: Unlike the Asset Browsers in other Vertigo Suite applications, 
the Asset Browser in Xnews only contains five (5) root categories: 
Pages, Templates, Clips, Work Orders, and Jobs.

Asset Browser
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Fig. 3-4: Click the gripper bar to open or hide the Asset Browser

Another way to reopen the Asset Browser when a page or template is open in the Xnews 
Home Area is to click the Create new button  in the Xnews toolbar. The page/template 
immediately closes in the Home Area and the Asset Browser and Asset Gallery return to 
their previous state.

Refreshing a category
The benefit of having the Xmedia Server centrally archive all of the assets (i.e. pages, 
templates, images...etc.) is that anybody on the network can ingest, create, or access these 
assets at anytime. Since the contents of the Xmedia Server may be changing during your 
Xnews session (as others add, edit, or remove assets), the Xmedia Server automatically 
refreshes the Asset Browser every time a change is saved to an asset or asset category.

This ensures that the Xnews Asset Browser always contains the latest versions of the assets 
stored on the Xmedia Server.

Although it isn’t necessary, you can refresh the Asset Browser by right-clicking on a 
category in the Asset Browser and selecting the Refresh command. The Asset Browser 
immediately reloads the category with the Xmedia Server content.

Fig. 3-5: The Refresh command reloads the category with the most recent content from the XMS

Adding a new category
The Asset Browser’s Pages, Templates, and Clips root categories are pre-set within the 
system and cannot be moved or deleted, nor can new ones be created. However, you can 
create as many subcategories within these root categories as required, as well as edit and 
delete them. 

Note: If the Hide the Asset Browser on open setting is enabled on the 
Preferences page in the Xnews settings, the Asset Browser will 
automatically collapse when a page or template is opened in the 
Home Area.

Click to open the Asset Browser Click to hide the Asset Browser
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Fig. 3-6: The Asset Browser organizes assets in a tree-structure of root categories and subcategories

To create a new category or subcategory:
1 Select the desired root category icon, so that its tree structure appears in the Asset 

Browser.
2 If you want the new subcategory to be immediately under the root category, right-click 

on the root category’ name in the tree. Otherwise, navigate to the subcategory in 
which you would like to create a new subcategory and right-click on its heading.
In both cases, the Asset Browser’s context menu appears.

3 Select the New Category command from the context menu. 
The New Category window appears.

4 Type the name of the new subcategory in the text box.
5 Click OK. 

The new sub-category is displayed below the category heading.

Setting access permissions for an asset category
If the Xmedia Server has been configured to support user rights management, the 
Permissions command will be enabled in the Asset Browser’s category context menu. 

Fig. 3-7: The Permissions command allows you to restrict access to the category to specific users

If the Permissions command is disabled in the context menu, this indicates that either the 
Authorization Manager is not installed; or that the Xmedia Server does not have its 
Authorization Manager Configuration settings enabled or set properly; or the user does not 
have access to the Policy Store.

Note: You cannot add or delete root categories from the Asset 
Browser in Xnews. You must use Xplorer, Xstudio, or another Vertigo 
Suite application to add or delete categories. Xnews however, does 
allows you to create as many categories within the root categories as 
you would like.

Root Category

Subcategories
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Complete instructions for configuring the Xmedia Server for user rights management and 
using the Permissions command are available in the “User Rights Management” section of 
the Xmedia Server Configuration Guide.

The following procedure describes how to set the Asset Browser’s category permissions to 
restrict access of a selected asset category to only a select group of users. 

To restrict access of asset category to only a select group of users:
1 Right-click on the asset category from the Asset Browser that you want to restrict 

access to. 
2 Select the Permissions command from the context menu. 

The Category Security window appears and states that there are currently no viewing 
restrictions set for the selected category. It further explains that the action of adding a 
user or a group instantly hides the category from every user except those users or 
groups add to this permission.

Fig. 3-8: Select the Permissions command to restrict access to the selected asset category

3 Click the Add button.
The Select Users or Groups window appears.

4 The text box provides a space for you to type the names of the user or group that you 
want to find. 

5 Click the Check Names button.
6 If only one match is found, then the name is immediately added to the text box. 

However, if multiple names match the search, then the Multiple Names Found window 
appears. Select the name of the user(s) that you want to add from the Multiple Name 
Found window and click OK.

7 The names are now listed in the Select Users or Groups window.
8 Click OK and the Select Users or Group window closes.

The Category Security window now lists the users and/or groups that have permission 
to view and interact with the assets in this category.

9 Click Apply to complete the procedure.

Related documentation
Please refer to the “User Rights Management” section of the Xmedia Server Configuration 
Guide for other procedures using the Permissions command.
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Asset Gallery, Home Area and Status bar
The pages, templates, work orders, and jobs that are stored on the Xmedia Server and 
associated devices are displayed or listed in the Asset Gallery. After selecting a root 
category or subcategory in the Asset Browser, the assets are displayed in the Asset Gallery. 
Some asset types can be displayed as thumbnail images (Proxy view) for easy 
identification, while others are displayed as lists which provide specific details about the 
assets (Detail view).

In addition to viewing the contents of the Xmedia Server, the Asset Gallery has a context 
menu that features a series of commands that are used to perform various tasks using the 
selected asset.

While the following sections describe the Asset Gallery views and commands, further 
chapters in this document provide instructions for using these features.

• Changing the view style (Detail or Proxy), on page 29
• Opening a template or page in the Home Area, on page 30
• Changing the edit and creation settings for shared pages, on page 31
• Zooming in/out of a template or page on the Home Area, on page 32
• Displaying a listing of Work Orders or Jobs, on page 32

Fig. 3-9: The Home Area replaces the Asset Gallery when a template or page is opened in Xnews

Changing the view style (Detail or Proxy)
When the Pages or Templates category or subcategories is selected in the Asset Browser, 
its assets are displayed in the Asset Gallery. Depending on the view setting (Proxy or Detail) 
the assets will be displayed in the Asset Gallery in a list/table or as a series of thumbnail 
graphics.

You can change the view style by clicking the Change the view button  selecting either 
the Detail View or Proxy View commands.

Asset Gallery in Proxy View mode

Home area displaying a shared page
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Fig. 3-10: Use the Change the View button to toggle between Proxy View and Detail View

Opening a template or page in the Home Area
Since templates and shared pages are stored on the Xmedia Server, they can be accessed 
by navigating through the Asset Browser and Asset Gallery. Embedded pages, however, 
exist only within a rundown. Therefore to open an embedded page, you must open the 
rundown first in your NRCS interface and then access the page from there.

The following procedures provide instructions for opening templates, shared pages, and 
embedded pages within the Xnews Home Area.

To open a template or shared page in the Xnews Home Area:
1 Open the Asset Browser and navigate through the Pages or Templates categories until 

the desired page/template is listed or displayed in the Asset Gallery.
2 Open the page or template by performing one of the following:

• Double-click the page/template in the Asset Gallery.
Or,

• Right-click on the page/template in the Asset Gallery and select the Open 
command.

To open an embedded page from a host news system’s story:
1 In the NRCS interface (i.e. ENPS or iNews), open the rundown and story that contains 

the page that is to be displayed in Xnews.
2 Double-click on the MOS entry for the page that you want to display in Xnews and the 

page opens in the Xnews Home Page.

Fig. 3-11: Opening an embedded page in Xnews

Note: The Startup View field on the Xnews Preference settings page 
dictates in which view mode Xnews uses as its default view. See 
Preferences settings, on page 14 for more information.
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Changing the edit and creation settings for shared pages
Xnews features two (2) settings that determine whether or not users can create and/or edit 
shared pages:

• Allow Creation of Server Pages, on page 31
• Allow Edit of Server Pages, on page 31

These two (2) settings can be access and enabled/disabled on the Xnews Preference 
settings page.

Fig. 3-12: Two Preference settings that control the creation and editing of shared pages

Allow Creation of Server Pages
The Allow Creation of Server Pages setting in the Xnews Preference settings is a 
mechanism for granting or restricting permission for users to create and save new shared 
pages to the Xmedia Server. 

When this setting is enabled (checked), the Save Page button  in the Xnews toolbar is 
enabled (blue), which allows you to save a shared page. However, when the setting is 
disabled (empty), the Save Page button  in the Xnews toolbar is disabled (grey) and it 
does not allow you to save the page to the Xmedia Server.

Allow Edit of Server Pages
The Allow Edit of Server Pages setting in the Xnews Preference settings is a mechanism for 
granting or restricting permission for users to edit shared pages that are stored on the 
Xmedia Server.

When this setting is disabled (unchecked), the Shared Page icon  in the Xnews Status 
bar displays a small lock, which signifies that no edits can be made to the page. However, 
when the setting is enabled (checked), the Shared Page icon  in the Xnews Status bar 

Note: If your intent is to create a shared page, but an embedded page 
is created from the template instead, check to see if the Allow Creation 
of Server Pages setting is enabled in the xnews.ini file. Similarly, if the 
Save Page window does not appear when you press the enabled Save 
Page button, the UseQuietMode2 parameter in the xnews.ini file 
might be enabled. See Enabling Embedded Pages or Shared Pages 
mode, on page 9 for instructions on changing these settings.
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does not display a lock and users can make changes to the page’s editable fields. See 
Editing and previewing a shared page, on page 68 for instructions on editing shared pages.

Fig. 3-13: The Shared Page icon indicates whether or not a page can be edited

Zooming in/out of a template or page on the Home Area
When a page is open in the Xnews Home Area, you can use your mouse’s wheel to zoom in 
and out of the page. Pressing your keyboard’s Home key returns that page’s view to its 
original size in the Home Area.

You can then move the page up or down in the Home Area by holding down the Alt key 
and pressing the Up arrow or Down arrow keys on your keyboard.

Fig. 3-14: Use the mouse wheel to zoom in and out of the page

Displaying a listing of Work Orders or Jobs
The Xnews Asset Browser not only displays the root categories for Pages and Templates, it 
also displays root categories for Work Orders And Jobs. Upon selecting these root 
categories, a listing of all of the Work Orders or Jobs is displayed in the Xnews Home Area.

Fig. 3-15: Access listings of Work Orders and Jobs using the Asset Browser and Asset Gallery

Shared page can be edited

Shared page cannot be edited

Work Orders Jobs
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When Work Orders or Jobs are listed in the Asset Gallery, the lower portion of the pane 
contains a filtering tool. You can use the filter to limit the number of listings displayed by 
specifying a set of restrictions or properties that the results must conform to (e.g. only work 
orders that are currently in a Pending state).

Full instructions for using the Work Order management system are provided in Creating 
and using Work Orders, on page 35.

Using the Drag bar to create embedded pages and clips
The Drag bar is located along the left side of the Xnews interface and is easily identified by 
the Vertigo X Media logo that is written across it. 

The Drag bar provides access to the Change Settings command, which allows you to 
specify settings that affect the functionality of Xnews. See Configuring the Xnews settings, 
on page 13 for more information.

Fig. 3-16: The Drag bar provides access to the Xnews Settings window

The Drag bar allows you to drag and drop the currently open page/clip into the host news 
system. You click the Drag bar while holding down the left mouse key and start moving the 
mouse across the story panel, the cursor changes to a drag icon  and the drag-and-drop 
functionality is initiated. Place the cursor in the location in the story where you want the 
page to be ordered and release the mouse key. The page/clip’s MOS entry is added to the 
story and the page closes in Xnews. See Saving and adding embedded pages to a story, on 
page 64 for more information.

Fig. 3-17: Using the Drag bar to add a page to the NRCS story
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Searching for assets on the Xmedia Server
Clicking the Search button  on the toolbar opens the Search XMS window, which allows 
you to quickly search for assets stored on the Xmedia Server. Once a search is launched, 
assets that match the name, type, description, author, keywords and/or Recall ID are 
displayed as thumbnails in Proxy View or listed in a table in Detail View.

With the search results displayed in the results pane, you can:
• Replace an existing image, clip or cel animation by dragging an asset of the equivalent 

type from the search results onto a page open in Xnews.
• Open a specific Page or Template asset in Xnews by double-clicking the asset in the 

search results.
• Open a specific Work Order or Job in the Work Order window by double-clicking the 

asset in the search results.

To search for assets stored on the Xmedia Server:
1 Click the Search button  to open Search XMS window.
2 Type a search query in the Search XMS text box. 

See the Xplorer User Guide for descriptions and examples of the syntax you can use to 
build more effective search queries.

3 Optional: Limit Search XMS results to specific asset types. 
By default, all asset types are evaluated by the search query as indicated by the Type 
drop-down box set to All Types. 

• To limit the search results to one asset type, select an asset type from the Type 
drop-down list. 

• To limit the search results to multiple asset types, click the Browse  button to 
open the Select Types To Search dialog. Select the asset types that you want 
included in the search and uncheck the asset types that you want excluded from 
the search results.

4 Click the  button to launch the search.
Assets that satisfy the search query are displayed in the results pane of the Search XMS 
window. 

5 Browse the results and select an asset of interest. Depending on the asset type, perform 
one of the following actions:

Note: The Search XMS window uses Solr, which a web-based solution 
by the Apache group that performs fast searches across large 
amounts of data. The Xmedia Server must maintain a connection to 
Solr so that it can create an index of the database. See the Xmedia 
Server Configuration Guide for more information.

Note: If an expected asset is not returned in the search results, it may 
be because user rights management is enabled on the Xmedia Server 
and the current user does not have permission to view the asset. See 
“User Rights Management” in the Xmedia Server Configuration Guide 
for more information.
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• Replace an existing image, clip or cel animation by dragging an asset of the 
equivalent type from the search results onto a page open in Xnews.

• Open a specific Page or Template asset in Xnews by double-clicking the asset in the 
search results.

• Open a specific Work Order or Job in the Work Order window by double-clicking 
the asset in the search results. Note that the Search XMS window closes 
automatically.

Creating and using Work Orders
While creating or editing a page, you may realize that the Xmedia Server does not contain 
the specific image or video clip asset that you need for your story. In such a case, Xnews 
allows you to create a work order, which is a set of requests directed at your graphics 
department for the creation and addition of the required asset to the Xmedia Server. Each 
request in the work order is known as a job. While creating the job request, you can insert a 
placeholder on the page. Once the asset is ingested into the Xmedia Server and the job is 
complete, the placeholder is automatically replaced by the new image/video and the page 
is ready to go to air. 

Xnews also allows you to view all of the work orders and jobs on your system through the 
Asset Browser’s Work Orders and Jobs categories.

The following sections describe how to create and use work orders and jobs in the context 
of the Xnews application:

• Creating a new work order and an initial job request, on page 36
• Viewing existing work orders and/or jobs, on page 38
• Adding a job to an existing work order, on page 38
• Removing a work order or job from the Xmedia Server, on page 39
• Fulfilling jobs using assets stored on the Xmedia Server, on page 40
• Fulfilling jobs using images from the AP Graphics Bank, on page 41

Note: The Work Order Management System is a feature that must be 
installed and configured on the Xmedia Server. For a more detailed 
description about configuring the Work Order Management system, 
please refer to the Xmedia Server Configuration Guide.
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Creating a new work order and an initial job request
If the Xmedia Server does not contain an image or video clip asset that you require for your 
template-based page, you can create a work order and job request. The work order’s job 
issues a request to your graphic arts department to create an asset that fulfills your 
prescribed specifications and then ingest it into the system.

Before creating a new work order, it is recommended that you verify that the image or clip 
that you require does not already exist on the Xmedia Server.

To verify if an image or clip already exists:
1 With the page open in Xnews, right-click the image or clip that is to be replaced.

Either the Select an Image or the Select a Clip window appears.
2 Browse through the categories within the window to see if any of the existing images 

or clips meet your requirements.
• If so, select the asset and press OK. The image or clip will immediately be brought 

into the page.
• If not, then proceed to creating a work order for your story or rundown, and specify 

a particular job request for the required image or clip.

To create a new work order:
1 With the page open in Xnews, select the New Work Order button  from the toolbar.
2 Each time you begin a new Xnews session and you attempt to create or access a work 

order or a job, the VertigoXmedia Login window appears and prompts you to sign in 
using a user name and password. If you do not have a user name and password, contact 
your IT department and ask them to add you to the Xmedia Server’s Workflow>Users 
properties.
Once you enter your user name and password, press OK and the Work Order Window 
appears.

Note: Before creating a work order or job from Xnews, your Xmedia 
Server system must first be configured to contain a work order 
workflow. You must also have the correct permission settings in your 
user profile to allow you to create work orders and jobs. Contact your 
system administrator for more information regarding your 
organization’s work order workflow configuration.

Note: You can allows use the Search Tool to verify if an image or clip 
already exists in the system. See Searching for assets on the Xmedia 
Server, on page 34 for instructions.

Note: The entire login step is avoided if the Windows user name 
matches the user name in the XmediaServer Properties’ Workflow 
options. If this is the case, then the user will automatically be logged 
on under the logged in name and the VertigoXmedia Login window 
does not even appear.
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3 In the Summary text box, type a short description of what story or rundown the work 
order applies to (i.e. 11PM news).

4 In the Due field, specify the date and time by which all of the jobs in the work order are 
required to be finalized in the system. You can either type the date directly in the date 
text box, or press the drop-down arrow to open and use a calendar to select the date. 
Similarly, you can either type the time in the text box, or select use the up and down 
arrows.

5 In the Priority drop-down list, select one of the available priority levels to indicate to 
the graphic arts department the urgency of the work order request. The default priority 
levels are: Low, Normal, High, and Urgent. The meaning and use of the priority levels 
should be determined within your organization and configured in the Priorities 
workflow options on the XMS Panel application.

6 Depending on Xnews’ Work Order Options and the workflow defined on the Xmedia 
Server, the first job can be automatically created when the work order is created and 
the job is already listed in the Jobs table and its properties are ready to be filled in. 

• In the Title field, type a short title that describes the subject of the image or clip 
requested.

• In the Assignee field, select from the drop-down list the name of the person that 
you want to assign the job to (i.e. the name of the graphic artist). 

7 Add a placeholder to the page by dragging the X-logo onto the page where the image 
or clip is located. The Just created placeholder is inserted on the page and the Job’s 
Asset information (type, name, category, and dimensions) are updated.

Fig. 3-18: Adding a job’s placeholder to a page

8 Once the job(s) are created for the work order, you must save the work order by 
pressing the Save Work Order button  in the Work Order toolbar.

9 The Work Order dialog automatically closes and the new work order is entered into the 
system.
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Viewing existing work orders and/or jobs
All saved work orders and jobs are stored on the Xmedia Server. You can view and open 
existing work orders and jobs using Xnews’ Asset Browser and Asset Gallery.

To view a list of the existing work orders and open a specific work order:
1 Select the Work Orders root category in the Asset Browser.

A list of all of the existing work orders now appears in the Asset Gallery.
2 Optional - If you cannot find the work order that you are looking for, use the Filters tool 

in the lower portion of the Asset Gallery to place restrictions on the listing.
3 To open a work order, simply double-click the work order’s row in the Asset Gallery’s 

list. The Work Order window opens and displays all of the work order information and 
lists the jobs associated with the work order.

To view a list of the existing jobs and open a specific job:
1 Select the Jobs root category in the Asset Browser.

A list of all of the existing jobs now appears in the Asset Gallery.
2 Optional - If you cannot find the job that you are looking for, use the Filters tool in the 

lower portion of the Asset Gallery to place restrictions on the listing.
3 To open a specific job, simply double-click the job’s row in the Asset Gallery’s list. 

The Job window opens and displays all of the information associated with the job.

Adding a job to an existing work order
Jobs must belong to a work order. Therefore, to create and submit a job request for a new 
image or clip, you must first create a work order and then create a job request , or add a new 
job to an existing work order.

To add a new job to an existing work order:
1 Open an existing work order. 

The Work Order window appears and displays all of the work order information and 
lists the jobs associated with the work order.

2 To add a new job, select the Add Job button  in the Work Order toolbar. 
A job is added to the Jobs list.

3 In the Title field, type a short title that describes the subject of the image or clip 
requested.

4 In the Assignee field, select from the drop-down list the name of the person that you 
want to assign the job to (i.e. the name of the graphic artist). 

Note: Depending upon your Work Order Workflow definition, the user 
names that appear in the Assignee drop-down list might be limited to 
only those who are assigned the same role as the Target Role setting 
on the Assign Transition’s properties on the XMS Panel application. If 
the desired user’s name does not appear in the Assignee list, verify 
that the user’s role and the Assign transition’s properties match.
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5 In the Comment tab’s text box, provide instructions and/or specifications to guide the 
graphic artist, so that they can provide you with an image or clip that meets your 
specific requirements.

6 Add a placeholder to the page by dragging the X-logo onto the page where the image 
or clip is located. The Just created placeholder is inserted on the page and the Job’s 
Asset information (type, name, category, and dimensions) are updated.

7 Click the Save Work Order button  to save the job and the work order. 

Removing a work order or job from the Xmedia Server
Xnews allows you to delete unwanted work orders and jobs from the Xmedia Server.

To delete a work order or job from the Xmedia Server:
1 Select the Work Orders root category or the Jobs root category in the Asset Browser.

A list of all of the existing work orders or jobs appears in the Asset Gallery.
2 Optional - If you cannot find the work order or job that you are looking for, use the 

Filters tool in the lower portion of the Asset Gallery to place restrictions on the listing.
3 Select the work order or job that you want to remove, or to select multiple work 

order/jobs, press the SHIFT key as you click on each one for consecutive selections, or 
press the CTRL key to select a grouping of non-consecutive work orders/jobs. 

4 Right-click on the selection and select the Delete command.
5 The Delete WorkOrder window appears and asks you to confirm your intention to 

delete the work order(s) or job(s).
6 Press OK.

Note: You can save a job without a placeholder, then use the Search or 
Ingest buttons to locate and attach a placeholder to the job. This 
placeholder will not exist on any page at this point, but it can be 
dragged afterward onto a page, or simply left alone in its category. 
Also note, that in the distributed work order case, on the hub the 
Ingest and Search buttons are disabled for empty-placeholder jobs 
because only spokes are allowed to make placeholders for distributed 
work orders. See the Xmedia Server Configuration Manual for more 
information about the Hub and Spoke model and distributed work 
orders.
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Fulfilling jobs using assets stored on the Xmedia Server
The XMS Search button on the Work Order and Job windows opens the Search XMS 
window, which allows you to quickly search and find assets stored on the Xmedia Server. 
Once a search is launched, assets that match the name, type, description, author, keywords 
and/or Recall ID are displayed in either a Proxy View or Detailed View and ordered by 
relevance to the search criteria. You can then use the assets listed to fulfill the job request.

To search for assets stored on the Xmedia Server:
1 Open an unfulfilled job in the Work Order window or Job window.
2 Click the XMS Search button  to open Search XMS window.

3 Type a search query in the Search XMS text box. 
See the Xplorer User Guide for descriptions and examples of the syntax you can use to 
build more effective search queries.

4 Optional: Limit Search XMS results to specific asset types. 
By default, all asset types are evaluated by the search query as indicated by the Type 
drop-down box set to All Types. One exception however, is if the job already has a 
placeholder associated with a page or template. In this case, the Type is already 
restricted based on the asset type of the placeholder.

• To limit the search results to one asset type, select an asset type from the Type 
drop-down list. 

• To limit the search results to either the Image or Clip asset types, click the browse 
 button to open the Select Types To Search dialog. Select the asset types that 

you want included in the search and uncheck the asset types that you want 
excluded from the search results. Click OK.

5 Click the  button to launch the search.
Assets that satisfy the search query are displayed in the Results pane of the Search XMS 
window. 

6 Browse, sort and add an asset to the job.
• When the Proxy View button  is selected, the assets appear as thumbnails in 

order of relevance to the search criteria. Double-clicking the asset’s thumbnail 
automatically adds the asset to the job.

• When the Detail View button  is selected, the assets are listed in a table and 
sorted by relevance to the search criteria. Clicking the column headings allows you 

Note: The Search XMS window uses Solr, which a web-based solution 
by the Apache group that performs fast searches across large 
amounts of data. The Xmedia Server must maintain a connection to 
Solr so that it can create an index of the database. See the Xmedia 
Server Configuration Guide for more information.

Note: When the Graphics Bank Enabled setting is selected on the 
Xmedia Server Control Panel, the Search button in the Work Order and 
Job windows is shared by two search tools: XMS Search and AP Search. 
If the AP Search button is currently displayed, click the arrow and 
select the Search XmediaServer option.
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to sort the results based on that column. Double-clicking the asset’s row 
automatically adds the asset to the job.

Fulfilling jobs using images from the AP Graphics Bank
The Associated Press (AP) Graphics Bank is a breaking news and archive image service that 
offers an extensive selection of images for on-air broadcasters. 

When the Graphics Bank Enabled check box is selected on the Xmedia Server Control 
Panel, the Search button in the Work Order window provides integrated access to the AP 
Graphics Bank allowing you to search for suitable images to fulfill the job.

To fulfill an image request job using the AP Graphics Bank:
1 Ensure that the AP Graphics Bank settings are enabled and configured on the Xmedia 

Server Control Panel. See page 24 and “Enabling AP Graphics Bank components” in the 
Xmedia Server Configuration Guide.

2 Open a job in the Work Order window. 
The Search button in the Work Order window allows searching in both the Xmedia 
Server and in the AP Graphics Bank. 

If the XMS Search button is currently displayed, click the arrow and select the Search 
AP Graphics Bank option.

3 Click the AP Search button.
The AP Graphics Bank: Search window appears. 

4 Search for a suitable image by entering a search query (keyword or boolean string) in 
the text box and clicking the search  button. See page 73 for more information 
about managing the search results.

Note: If an expected asset is not returned in the search results, it may 
be because user rights management is enabled on the Xmedia Server 
and the current user does not have permission to view the asset. See 
“User Rights Management” in the Xmedia Server Configuration Guide 
for more information.
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5 Once you have found an image that you want to use, select one of the following 
options from the drop-down button below the Sort field:

6 Purchase the selected image and set the image’s properties by following the 
instructions on page 74.

Purchase and 
Ingest

Ingest the full resolution version of the selected image and 
use this image to replace the placeholder in the current Job. 
This operation constitutes a purchase of the image and the 
AP Graphics Bank: Purchase Images window appears.

Purchase, Ingest & 
Attach

Ingest the full resolution version of the selected image and 
use this image to replace the placeholder in the current Job. 
In addition, add the image as an attachment in the Job. 
This operation constitutes a purchase of the image and the 
AP Graphics Bank: Purchase Images window appears.  
The image added as an attachment to the Work Order job 
can be saved to disk.

Purchase and 
Attach

Download the full resolution version of the selected image 
and add the image as an attachment in the Job. 
This operation constitutes a purchase of the image. 
The image is added as an attachment to the Work Order job 
and can be saved to disk.
Note that the image is not ingested into the Xmedia Server.

Ingest Preview Ingest the low resolution preview version of the selected 
image and use this image to replace the placeholder in the 
current Job. 
This operation does not constitute a purchase of the image. 
However, to finalize the Job using the preview image, the 
image must be purchased.

Note: When a Playlist Verification is performed in Xbuilder or Xplay, if 
an element in a playlist contains one or more AP Graphics Bank 
preview images that have not been purchased, the status of that 
element displays as Assets Awaiting Purchase until the images are 
purchased.
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A prerequisite to using Xnews to create pages is that the Xmedia Server must contain the 
templates upon which the pages will be created. If the templates do not already exist, or if 
the templates require edits, you must use Xstudio to create/edit the template before using 
Xnews.

Once the templates are available on the Xmedia Server, you must decide whether you will 
want to create embedded pages or shared pages. This decision must be made in advance 
of creating your page because Xnews must be configured to operate in either embedded 
pages mode or shared pages mode.

The information in the following sections will help you to create a template, as well help 
you to decide if you want to create embedded pages or shared pages:

• Creating templates in Xstudio, on page 44
• Choosing between embedded, shared or private pages, on page 45
• Creating a clip template in Xstudio for clip playout, on page 46
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Creating templates in Xstudio
Templates are built in Xstudio and determine the layout and contents of the on-air 
graphics. Meanwhile, pages are instances of a template, which means that the layout is 
already done and all you have to do is enter into the template’s variable fields the text, 
images, or video clips that are specific to the required broadcast graphic. No matter how 
many times the page is edited, the page retains its ties to the template that it was created 
from. The advantage of this is that changes to the template are easily propagated to all of 
the pages that were built from using that template.

The following procedure provides a high-level overview of how to create a template in 
Xstudio. These instructions are only intended to illustrate the template requirements for 
creating pages in Xnews. For complete information about creating and using templates in 
Xstudio, see the “Xstudio User Manual”.

To create a template in Xstudio:
1 Open Xstudio by selecting Start>Programs>VertigoXmedia>Xstudio.

The Create New window appears in the Xstudio window upon opening.
2 Select Template + Scene from the Create New window and then click OK.

An empty template canvas appears and is ready to be populated.
3 Build the template by populating the template’s canvas with assets and/or primitives.

• Open the Asset Browser, then drag and drop one or more image, cel animation, 
and/or clip assets onto the template’s canvas.

and/or
• Drag and drop one or more of the following primitives from the Primitives toolbar 

to the template’s canvas: Text, Dropbox, Button, Textbox, Image, Checkbox, Radio 
Button, Active X, Timer.

4 Move, resize, align, or layer the objects on the template’s canvas to achieve the desired 
layout. See the “Xstudio User Manual” for instructions on how to perform these tasks.

5 Use the Property Browser to set the property parameters for each individual object on 
the template’s canvas. See Xstudio User Manual for descriptions of each of the 
properties that can be set.
Of particular relevance to pages for Xnews are the Allow Edits property and the 
properties under the Links category (e.g. Lookup table, Data Source...etc.).

• A page’s image, cel animation or clip assets can only be replaced in Xnews if the 
asset’s Allow Edits property is enabled on the template in Xstudio. Therefore, as 
the template’s author you can allow users to replace the object when creating a 
page by setting the Allow Edits property to True. Meanwhile, a False value 
prevents the asset from being replaced on a page in Xnews.

• Setting the properties within the Links category in the Property Browser allows 
you to define when and how the object will be populate with data (e.g. Data 
Source or Lookup Table).
44



Xnews
User Manual
6 Use the Action Editor to associate the template’s objects with actions that are executed 
when a specific event occurs either in Xnews or during playout.

Fig. 4-1: Use the Action Editor to associate a template’s object with an action and event

7 Save the template by selecting File>Save.
The Save Template window appears allowing you to specify a name for the template 
and into which category the template will be stored on the Xmedia Server.

Choosing between embedded, shared or private pages
Before using Xnews to create graphics pages for broadcast, we recommend that you 
determine whether you want to create embedded pages, shared pages or private pages. All 
three types of pages provide the same playout performance in a rundown. The main 
considerations that should be taken into account is whether the page is intended to be 
included in only one or many stories and whether the page asset is required to be stored 
and managed on the Xmedia Server.

Embedded pages exist only within a story, and it is the rundown that is saved as a whole in 
the Xmedia Server. As a result, the individual page does not exist anywhere else, not even in 
the Pages root category of the Asset Browser. An advantage of using embedded pages is 
cleanup - once the rundown is deleted, all the pages in it are gone too. Therefore, the 
Xmedia Server does not accumulate large quantities of unused/unwanted assets. The use 
of embedded pages is commonly preferred in newsroom environments since pages are 
usually created for a specific story or rundown and then they are no longer needed. By 
default, Xnews is configured to run in Embedded Pages mode (see Enabling Embedded 
Pages or Shared Pages mode, on page 9).

Shared pages exist in the Xmedia Server (accessed from the Asset Browser) as distinct 
assets and can be used in many different stories as a common item. The benefit of using 
shared pages is that only one “copy” of that page needs to be updated for the updates to 
apply to all of the stories that include that page. The drawback of using shared pages is that 
deleting the shared page asset from the Xmedia Server affects all stories that use that page. 
By default, Xnews is configured to run in Embedded Pages mode, which only allows you to 
create embedded pages.To create shared pages in Xnews, you must disable the 
EnableEmbeddedPages setting in the xnews.ini file (see Enabling Embedded Pages or 
Shared Pages mode, on page 9).

Private pages are exclusively meant to replace the use of embedded pages for MOS 
workflows in ENPS. In this particular application, embedded pages were previously used 
which sometimes resulted in ENPS performance issues. The strategic characteristics of 
private pages remedies these issues.

Private pages can only be created in Xnews and like shared pages, they exist as distinct 
assets, however unlike shared pages they are not visible from the Asset Browser. 
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Since private pages exist only in the Xmedia Server, their lifetime must be managed by the 
Xmedia Server. When a private page is no longer needed, it must be removed from the 
Xmedia Server. The Unreferenced Private Page Expiry setting determines how long a 
Private page is kept in the Xmedia Server after it has been deleted, floated, archived or its 
rundown has been made MOS Control Inactive.

Private page names must be valid Xmedia Server asset names and are limited to any 
alphanumeric character, space, hyphen and underscore characters. Private pages do not 
support recall IDs, so giving a private page a uniquely numeric name does not support the 
usual recall id functionality.

To create Private pages, you must enable the EnablePrivatePages setting in the 
xnews.ini file (see Enabling Privates Pages mode, on page 10).

While most of the procedures are the same for creating or editing embedded, shared or 
private pages, there are some differences in the way in which they are accessed and saved. 
Therefore, we recommend that you follow the procedures in the relevant chapters below:

• Embedded Pages: Creating, editing and previewing, on page 49
• Shared Pages: Creating, editing and previewing, on page 65

Fig. 4-2: Identifying whether a page is an embedded page or a shared page

Creating a clip template in Xstudio for clip playout
Clip assets can be directly added to a story and played out as part of the rundown. For the 
clip to be cued and played out to a device, you must first create and publish a “clip 
template” in Xstudio. The clip template must contain a clip texture on both the template 
and scene side. The clip texture on the scene side must then be associated to the clip 
texture on the template side. By setting the texture on the template side, we are able to 
display the clip proxy on the template in Xplay and the linking takes care of setting the clip 
object on the scene side.

Once the clip template is saved to the Xmedia Server and published to the device, you must 
set the Clip Template and Clip Object Name fields on the device’s configuration in the 
Device Manager.

The following topics provide instructions for how to create a clip template and set the 
device configuration settings for clip playback:

• Creating a clip template, on page 47
• Specifying the clip template on a device’s configuration, on page 47

This icon indicates 

Shared pages are stored
on the Xmedia Server

that the open page is a
shared or private page.
If no icon appears,
then the open page
is an embedded page.
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Creating a clip template
To create a clip template in Xstudio:

1 Open Xstudio by selecting Start>Programs>VertigoXmedia>Xstudio.
The Create New window appears in the Xstudio window upon opening.

2 Select Template + Scene from the Create New window and then click OK.
An empty template canvas appears and is ready to be populated.

3 Place an Image texture on the template’s canvas by selecting the Image primitive icon 
 and dragging the texture onto the canvas.

4 Select the Scene tab and place a clip object on the scene’s canvas by selecting the Clip 
primitive icon  and dragging the object onto the canvas.

5 Select the Template tab to return to the Template side. 
6 Link the template side’s image texture to the scene’s clip object by dragging the clip 

object in the scene tree and dropping it onto the image texture. 
Be sure to place and size the clip object within the scene’s safe areas.

7 Save the template to the Xmedia Server by selecting File>Save. Specify a name and 
category for the template in the Save Template window. Then, click OK.

Specifying the clip template on a device’s configuration
To specify a clip template on a device’s configuration:

1 Open the clip template in Xstudio and take note of its name, category location, and the 
name of the texture on the template side.

2 Open the Device Manager window by selecting Tools>Devices>Configure Devices.
The Device Manager (Device Configuration window) appears.

3 If the device is connected (appears in the Device box on the right side), click the left 
arrow button  to disconnect it and make it available for editing.
The device box becomes empty.

4 Select the device name in the table and click the Edit button.
The Device Manager window expands to reveal the Edit Device Configuration settings.

5 Click the browse button  next to the Clip Template field.
The Select Clip Template window appears.

6 Navigate to the Clip Template, select the asset, and then click OK.
The Select Clip Template window closes and the clip template’s name appears in the 
Clip Template field on the Device Configuration window.

7 Type the name of the texture on the template side of the clip template in the Clip 
Object Name field.

8 Click Apply.
The Edit Device Configuration settings close.

9 Reconnect the device by selecting the device’s name from the table and then clicking 
the right arrow button . The device now appears in the Device box on the right.

10 Click the Close button to close the Device Configuration window.
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previewing
By default, Xnews is configured to run in Embedded Pages mode, which allows you to 
create embedded pages that exist only within a story/rundown, rather than being saved as 
an asset on the Xmedia Server (i.e. shared page). The Embedded Page configuration is 
preferred in most cases since pages are usually created for a specific story or rundown and 
then they are no longer needed. So rather than storing and deleting all of the individual 
page assets, embedded pages are saved within the rundown, and only the rundown is 
required to be deleted when it is no longer needed.

The following topics provide practical information and instructions for creating, editing and 
previewing embedded pages using Xnews:

• Creating a new embedded page from a template, on page 50
• Opening an existing embedded page, on page 51
• Changing a template’s editable fields, on page 51
• Replacing an image, cel animation or a clip on a page, on page 53
• Using the Image Editor to edit a page’s image and create a new image asset, on page 54
• Using In Place Image Edit mode to zoom and pan a page’s image, on page 59
• Previewing the on-air look of a page locally, on page 61
• Creating a Remote Preview of a page, on page 62
• Saving and adding embedded pages to a story, on page 64

Note: Although the default configuration sets Xnews to Embedded 
Pages mode, the instructions in Enabling Embedded Pages or Shared 
Pages mode, on page 9 will allow you to verify that your system is 
indeed configured in Embedded Pages mode.  
Also note that to create embedded pages you must ensure that the 
Enable Private Pages setting is either not present in the xnews.ini file, 
or that EnablePrivatePages=false.
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Creating a new embedded page from a template
Since pages are based on templates, you must first open the desired template to create a 
page from it. You can then edit the template’s editable fields (i.e. text, images, clips...etc.) 
and insert it into a news story as a new embedded page.

To create a new embedded page from a template:
1 Display the available templates in the Asset Gallery by clicking the Templates category 

in the Asset Browser and navigating down until the desired template is displayed in the 
Asset Gallery.
If a page is already open, click the Create new button  in the toolbar. This will close 
the open page, and then display the templates in the category that was last selected.
When the new page opens, the Asset Browser disappears. To display it again, click the 
orange gripper bar.

2 Double-click the template in the Asset Gallery from which you would like your page 
based. 
A new page is created based on the template and is opened for editing. The status bar 
indicates that the page has not yet been named and saved, and identifies the template 
on which it is based.

3 Modify the page’s replaceable fields as required (see Changing a template’s editable 
fields, on page 51 and Replacing an image, cel animation or a clip on a page, on 
page 53).

4 Set the page’s Offset and Duration settings that are displayed in the Status bar. See 
Displaying a listing of Work Orders or Jobs, on page 32.

5 Insert the page into the story. See Saving and adding embedded pages to a story, on 
page 64.
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Opening an existing embedded page
By definition embedded pages are not saved on the system, rather they are part of the story 
that they were inserted into. Therefore, to open an embedded page involves first opening 
the story in the NRCS workstation. Once the story is open, you can open, edit, and/or save 
changes to the page.

To open an existing embedded page:
1 With the NRCS workstation interface open, navigate to the rundown and story that 

contains the page that you want to open.
2 Open Xnews in the NRCS workstation interface.
3 Double-click the MOS entry for the page that you want to open.

The page opens in the Home Area of the Xnews interface.

Changing a template’s editable fields
Templates determine the layout and appearance of graphics pages and they can range in 
sophistication from very simple (i.e. an over-the-shoulder image) to multi-asset displays 
that use logic to determine the content and behavior of the resulting page.

Regardless of how simple or complex the template is, you can create a unique page from 
the template by editing the template’s editable fields. These editable fields may be:

• Text inside text boxes
• Selections from drop-down lists
• A selection from a series of radio buttons
• Single or multiple selections from check boxes
• An image, cel animation, or clip

Making changes to the editable fields follows the typical user interface behavior. For 
example, enabling/disabling a radio button or check box by selecting it, or filling in text by 

The embedded page
opens in Xnews

In the story, double-click
the embedded page’s
MOS entry

The Save Page & Close button
indicates that you are editing
a page that belongs to a rundown
(i.e. embedded page)
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selecting and typing inside a text box. Since changing an image, cel animation or clip is a 
little more involved, precise instructions are provided on page 53.

A quick way of identifying and navigating through the editable fields on a template or page 
is to click anywhere on the page and then click the Tab key to go from one editable field to 
the next.

Fig. 5-1: Customize pages by changing the editable fields on the template

Note: Not all fields on a template are designed to be editable. Whether 
or not a field is to be editable is determined by the creator of the 
template in Xstudio by enabling the field’s (asset’s) Allow Edit 
property. Therefore, if you select a field and you are unable to edit it, 
it most likely has been intentionally protected to enforce editorial 
standards.
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Replacing an image, cel animation or a clip on a page
A page’s image, cel animation or clip assets can be replaced in Xnews only if the asset’s 
Allow Edits property was enabled on the template in Xstudio. When the asset is added to 
template in Xstudio, the author can specify whether or not the asset can be edited/replaced 
by setting the asset’s Allow Edits property. Assigning a True value to this setting allows 
Xnews users to change the asset in Xnews. However, a False value prevents the asset from 
being replaced on a page in Xnews. This editorial restriction ensures that all of the pages 
that are created from the template have a consistent look and feel. 

Fig. 5-2: The Allow Edits property in Xstudio determines whether the image/clip can be edited in 
Xnews

To replace a page’s image, cel animation or clip in Xnews: 

While the following procedure only makes reference to images, these instructions also 
apply to replacing a cel animation or a clip on a page.

1 With the page open in the Home Area, right-click on the existing image that is to be 
replaced. 

• If the template allows the image to be edited, the Select an image browser 
window appears allowing you to view all of the images stored on the Xmedia 
Server.  
Note: If the desired image does not currently exist in the browser (i.e. on the 
Xmedia Server), you can create a work order request for its creation. See Creating 
and using Work Orders, on page 35 for more information.

• If nothing happens when you right-click, then the image’s properties are most 
likely set not allow Xnews users to edit or replace the asset on the page.

2 Either double-click on the desired image, or select it and then click OK. 
The Image Browser window closes and the image is updated on the page in Xnews.

Note: If a page’s image requires editing, you can access and use the 
Image Editor for performing minor editing tasks like adjusting the 
image’s color and sharpness or cropping the image.
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Using the Image Editor to edit a page’s image and create a new 
image asset

The Image Editor allows you to perform some basic image editing tasks to the image assets 
that appear on the template or page and then save the edited image as a new asset. 

To access the Image Editor from within Xnews:
1 With a page open in the Home Area, right-click on the image.

The Select an Image window appears.
2 Navigate to and select the image that is to be edited. 
3 Once the image is selected, click the Edit button.

The Image Editor window appears.

The following sections provide functional descriptions and instructions for how to use the 
Image Editor to edit an image and save it as a new asset:

• Zooming in/out and repositioning the image, on page 54
• Cropping an image, on page 56
• Making color adjustments, on page 57
• Adjusting the sharpness of an image, on page 58
• Using the Image Modification buttons to flip an image, on page 58

Zooming in/out and repositioning the image
When editing an image, it is often necessary to view the image, or a portion of the image, in 
greater detail. It is for this reason that the Image Editor allows you to magnify, or zoom in on 
the image, as well as zoom out to get an expanded or distanced view of the image.

When an image is opened in the Image Editor it is placed directly in the center of Editor’s 
canvas. However, when you zoom in on the image, you may not see certain areas of the 
image. To reposition the image within the display, while maintaining the zoom scale, you 
can pan across the image to the area that is otherwise outside of the window’s display. 

To zoom in/out of an image and save the edited image as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).
2 Use one of the following methods to zoom in on the image:

• Click the Zoom button  on the Image Editor’s toolbar. Your pointer transforms 
into a magnifying glass. Click the part of the image that you want to zoom in on. 
The Image Editor zooms in on the image in increments.

• Roll the mouse wheel forward.
• Click the + (plus) key on your keyboard’s number pad.

The mouse and keyboard methods zoom in on the center of the portion of the image 
that is currently displayed. As a result, you may need to pan across the image to view a 
particular area of interest.

Note: Click the Space bar on your keyboard and the zoom is reset to the 
images original scale (1:1).
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3 Use one of the following methods to zoom out of the image:
• Roll the mouse wheel backward.
• Click the - (minus) key on your keyboard’s number pad.

The mouse and keyboard methods zoom out from the center of the portion of the 
image that is currently displayed. As a result, you may need to pan across the image to 
view a particular area of interest.

4 Once you are satisfied with the new image, click OK. 
The Name new image window appears. 

5 Type the name of the new image asset and then click OK to replace the original image 
with the new image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

To reposition an image by panning and save the edited image as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).

2 Use one of the following methods to reposition an image by panning:
• Click the Pan button  on the Image Editor’s toolbar. Your pointer transforms 

into a hand. Drag the image in the direction (up/down, and/or right/left) required 
to reposition and display the desired portion of the image in the Editor’s canvas.

• When an upper or lower portion of the image is not visible in the Editor’s canvas, 
the canvas’ vertical scroll bar becomes active. Similarly, when the right or left 
portion of the image is not visible in the Editor’s canvas, the canvas’ horizontal 
scroll bar becomes active. Drag the scroll box up/down and/or back/forth to 
reposition the image on the Editor’s canvas.

• You can also use the keyboard’s direction keys (up, down, left, right, page up, and 
page down) to reposition the image in small increments.

3 Once you are satisfied with the new image, click OK. 
The Name new image window appears. 

4 Type the name of the new image asset and then click OK to replace the original image 
with the new image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

Note: Click the Space bar on your keyboard and the zoom is reset to the 
images original scale (1:1).

Note: Panning is only required, and therefore only available, when a 
portion of the zoomed image is not visible in the Image Editor’s canvas. 
In such a case, the canvas’ horizontal and/or vertical scroll bars become 
active.
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Cropping an image
The Image Editor’s cropping function allows you to conserve a selected portion of the 
image, while removing the remaining portions surrounding the selected area. Cropping is a 
popular image processing technique that is commonly used to focus the image on a 
particular subject or area on the image.

A bounding outline surrounds the image when it is opened in the Image Editor. The 
bounding outline is a frame that is used for defining the area of interest when using the 
cropping feature. In other words, the content inside of the bounding outline will be 
preserved, while whatever is outside the bounding outline will be permanently removed. 
When the Image Editor is in crop mode, dragging the bounding outline’s corner handles 
(squares) allow you use to resize the bounding outline around the area of interest on the 
image. If the “Use area of interest aspect ratio” check box is selected, then the bounding 
outline can only be resized to dimensions that maintain the aspect ratio of the image’s 
placeholder on the scene, template, or control panel. Clearing this check box allows you to 
resize the bounding outline freely without any aspect ratio restrictions.

When resizing or repositioning the bounding outline, its dimensions and location is display 
in the lower right corner of the Image Editor window. The first set of number displays the 
X/Y dimensions of the bounding outline in pixels, while the second set represents the 
location coordinates of the bounding outline’s upper left corner.

To crop an image and save the edited image as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).
2 With the image completely visible in the Image Editor, click the Crop button .
3 Resize and/or reposition the bounding area to include only the content to be 

preserved.
a Select the Use area of interest aspect ratio check box if you want to resize the 

bounding outline, but still maintain the aspect ratio of the image’s placeholder on 
the scene, template, or control panel. Clear the check box is you want to freely 
resize the bounding area.

b Drag the bounding outline’s sizing handles to resize the bounding outline around 
the area of interest. 

c If necessary, you can reposition the bounding outline within the image by clicking 
inside the bounding outline and dragging it over the area of interest in the image. 

4 Once the bounding outline contains only the area of interest, click OK.
The Name new image window appears.

5 Type the name of the new image asset and then click OK to replace the original image 
with the cropped image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

Note: Since cropping permanently alters the image, the Image Editor 
allows you to save a copy of the changed image before the cropping 
is actually performed. As a result you can preserve the original state of 
the image asset.
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Making color adjustments
The Image Editor allows you to adjust the color properties of an image asset. Color 
adjustments are applied immediately to the entire image, not just a specific area of interest. 
You can experiment with different color settings, however there is no way to undo your 
changes except to click the Reset All button, which returns the color settings to the state 
they were in when the image was last saved, or by clicking the Cancel button, which closes 
the Image Editor and the image asset remains unchanged.

To make color adjustments to an image and save it as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).
2 Adjust the image’s color properties by moving the property’s slider to the right or left.

3 Once you are satisfied with the new color settings, click OK. 
The Name new image window appears. 

4 Type the name of the new image asset and then click OK to replace the original image 
with the new image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

Contrast The difference in the luminance of the brightest and the darkest areas of an 
image. A high contrast will display an obvious difference (i.e. black versus 
white) in the luminance between two areas, while a low contrast makes the 
difference less obvious or more gradual (i.e. shades of grey).
• Move the slider to the right to increase the image’s contrast ratio.
• Move the slider to the left to decrease the image’s contrast ratio.

Brightness Generally, the brightness setting determines how light or dark a the colors of 
the image are based on how close the colors are to white. The more white a 
color has, the brighter it is.
• Move the slider to the right to increase the image’s brightness (until all white)
• Move the slider to the left to decrease the image’s brightness (until all black)

Saturation Saturation refers to the intensity of a specific hue. It is based on the color's 
purity; a highly saturated hue has a vivid, intense color, while a less saturated 
hue appears more muted and grey. With no saturation at all, the hue becomes 
a shade of grey.
• Move the slider to the right to increase the image’s saturation.
• Move the slider to the left to decrease the image’s saturation.

Gamma Alters the contrast of the mid-tone colors with little effect on pure white or 
black, which is the function of the Contrast property above. Increasing the 
gamma ratio increases the image’s highlight to shadow contrast in terms of 
mid-tone colors’ density values. Decreasing the gamma setting intensifies the 
shadows amongst the mid-tone colors.
• Move the slider to the right to increase the image’s gamma setting.
• Move the slider to the left to decrease the image’s gamma setting.
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Adjusting the sharpness of an image
The Image Editor allows you to adjust the sharpness setting of an image asset and then 
save the edited image as a new asset. The sharpness adjustment is applied immediately to 
the entire image, not just a specific area of interest. You can experiment with different 
settings, however there is no way to undo your changes except to click the Reset button, 
which returns the sharpness setting to the state it was in when the image was last saved, or 
by clicking the Cancel button, which closes the Image Editor and the image asset remains 
unchanged.

To adjust an image’s sharpness and save it as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).
2 Adjust the image’s sharpness property by moving the property’s slider to the right to 

increase the focus and to the left to blur the image.
3 Once you are satisfied with the new sharpness settings, click OK. 

The Name new image window appears. 
4 Type the name of the new image asset and then click OK to replace the original image 

with the new image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

Using the Image Modification buttons to flip an image
The Image Editor allows you to quickly change the orientation of an image by flipping it 
horizontally or vertically. 

Fig. 5-3: The Image Editor’s Image Modification buttons allow you to quickly flip image assets

To flip an image horizontally or vertically and save it as a new image asset:
1 Open the original image in the Image Editor (see Using the Image Editor to edit a page’s 

image and create a new image asset, on page 54).
2 Click either the Flip Horizontal button or the Flip Vertical button. 

The image flips immediately.
Note: Click the button again to return to the original orientation.

3 Once you are satisfied with the new image, click OK. 
The Name new image window appears. 
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4 Type the name of the new image asset and then click OK to replace the original image 
with the new image; or click Cancel to retain the original, unedited image.
The Image Editor closes automatically.

Using In Place Image Edit mode to zoom and pan a page’s image
In Place Image Edit mode allows you to select an image on the page being edited in Xnews 
and then zoom and/or pan to view a specific part of the image. The resulting changes to 
the image's appearance only affect the page and do not change the image asset itself.

Template requirements for using In Place Image Edit mode
In Place Image Edit mode is only available in Xnews if the page’s Template was designed in 
Xstudio using the following criteria:

• The Template’s control-side contains at least one Texture object (image) whose Allow 
In Place Pan/Zoom property is set to True.

• The Texture object must contain a valid image asset. In Place Image Edit mode is not 
accessible to Texture objects that contain video clips, cel animations, or no image at all.

• The Texture object must be linked to a Scene element of type Image.
• The bounding box of the Image object on the Scene must be given the same aspect 

ratio as the bounding box of the Texture object in the Template.

Zooming and panning an image using In Place Image Edit mode
To zoom and/or pan an image using In Place Image Edit mode:

1 Open a page in Xnews.
Note that the page’s template must satisfy all of the requirements described in 
Template requirements for using In Place Image Edit mode, on page 59.

2 Enter In Place Image Edit mode.
• Double-click on an individual Texture (image).

Or,
• Click the In Place Pan/Zoom  toolbar button. If multiple Textures (images) 

appear on the page, select a Texture from the drop-down list.

A thick border appears around the image and a three-button toolbar appears in the 

Note: If you would like to zoom and pan on a page’s image and then 
save the changed image as a new asset, see Using the Image Editor to 
edit a page’s image and create a new image asset, on page 54.

TIP
Although not a requirement, we recommend that both the Texture 
object in the Template and the associated Image object on the Scene 
have their Style property set to Keep Aspect and the Alignment 
property set to Mid Center. 
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upper-right corner to indicate that In Place Image Edit mode is active. 

3 Use one of the following methods to zoom in/out of the image:
• Zoom in: Roll the mouse wheel forward or press the Page Up key.
• Zoom out: Roll the mouse wheel backward or press the Page Down key.

4 Use one of the following methods to pan around the image:
• Hold the left mouse button and drag the image.

Or,
• Use the arrow keys on your keyboard to pan by 1 pixel in the direction of the arrow. 

Hold down the Shift key while using the arrow keys to pan 10 pixels in the direction 
of the arrow.

5 To exit In Place Image Edit mode, click one of the following buttons in the In Place 
Image Edit mode’s toolbar or use the keyboard operation:

Note: Normal mouse and keyboard operations are suspended when In 
Place Image Edit mode is active.

 Apply
or
Press Enter

Applies the changes made to the image and exits In Place Image Edit mode. 
Once the edits are applied, the Texture object’s Style and Alignment 
property settings are no longer used to situate the image in the Texture’s 
bounding box. Instead, the pan and zoom values specified during the in 
place editing are used.

 Revert Reverts the image back to its original state and exits In Place Image Edit 
mode. 

 Cancel
or
Press Esc

Cancels the current edits to the image and exits In Place Image Edit mode. 
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Previewing the on-air look of a page locally
While editing or creating of a page, Xnews allows you to preview the on-air playout 
appearance and behavior of the page on a designated device (e.g. Software CG).

Fig. 5-4: The playout of a page can be previewed on a device during creation

For the preview page functionality to be used, you must enable the Playout settings in the 
Xnews.ini file and the device must be exclusively available for Xnews connectivity. See 
Enabling the Playout Preview setting, on page 8 for instructions on how to enable the 
Playout preview mode.

Once these conditions are met, each time a page or template is opened in the Xnews Home 
Area, the Preview page button  appears in the toolbar allowing you to preview the 
page on the device.

To preview a page on a device:

With a page/template open in the Xnews Home Area, look to see if the Xnews toolbar 
contains the Preview Page  button.

If so, click the Preview Page button and the page is quickly published to the device and 
then played out on the device identified in the xnews.ini file.

If the Preview Page button does not appear in the toolbar, the Preview Page functionality 
has not been properly enabled. Return to page 8 and follow the instructions for enabling 
the Preview Page feature.

If the Preview Page icon appears in the toolbar but it has a red X over it , this indicates 
that the device is currently disconnected or not available to Xnews. For example, the device 
might be closed, or currently be used by or connected to another Vertigo Suite application. 
Click the Preview Page button to try to connect to the device. If the connection is re-
established then the Preview Page icon returns to its normal appearance and the page 
playouts on the device. If the Preview Page remains with the X over it, you must verify the 
availability of the device.
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Creating a Remote Preview of a page
When creating or editing a page in Xnews, you can preview an image of the scene’s home 
key frame that has been rendered by a remote renderer device. 

The Remote Preview functionality requires that the VertigoXG Remote Preview Renderer 
component be installed on a Remote Renderer workstation. A device configuration for the 
Remote Renderer must also be added to the central Xmedia Server’s Device Manager. 

Once these conditions are met, each time a page or template is opened in the Xnews Home 
Area, the Remote Preview button appears in the toolbar. When the button is clicked, an 
image of the scene at the home key frame appears in a pop-up window on the Xnews 
workstation.

Setting up the Remote Renderer workstation
The Remote Renderer workstation is a separate computer that is responsible for rendering 
pages and sending a preview image back to Xnews. 

The minimum specifications for the Remote Renderer workstation computer are:
• Intel Xeon E5-2620 (2 GHz, 15 MB cache, 6 cores) or greater
• 16 GB Memory
• 2TB Hard drive
• GPU: NVIDIA K2200 or greater
• Operating System: Microsoft Windows 7 Service Pack 1 (SP1)

To configure this computer as a Remote Renderer workstation, you must install the 
VertigoXG Remote Preview Renderer preset configuration. This preset configuration 
installs and automatically configures all of the local software components required to 
render the Remote Preview image. 

Installing the Vertigo Suite’s VertigoXG Remote Preview Renderer software option:
1 Access the Vertigo Suite Installer (v5.1 or later) from the Software Downloads section 

of the Grass Valley website.
2 Make a copy of the Vertigo Suite Installer and place it on the Remote Renderer 

computer.
3 Right-click the Installer file and select Run as Administrator.
4 Follow the Installer’s instructions.
5 On the Select Components page, select VertigoXG Remote Preview Renderer from 

the preset configuration drop-down list.
6 When prompted, restart the computer to complete the installation.
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Adding a Remote Renderer device to the Device Manager
To ensure that Xnews is able to connect to and communicate with the Remote Renderer 
device, you must add a device configuration for the Remote Renderer to the central Xmedia 
Server’s Device Manager.

To add a Remote Renderer device in the Device Manager:
1 Open the Device Manager in one of the following Vertigo Suite applications: Xplorer, 

Xstudio or Xplay.
2 Click the Add or New button to create a new device.
3 On the General tab, complete the following settings:

• Device Type: Select Remote Renderer
• Device Name: Enter the name of the device
• Control IP: Enter the IP address or hostname of the remote renderer workstation
• Control Port: Use the default value of 5006
• Device Alias: (Optional) An alternative name for the device on your network
• Description: (Optional) A label to help distinguish the device from others

4 Click Apply.

Rendering an image of a page using Remote Preview
The Remote Preview button appears in the Xnews toolbar when a page or template is 
open in the Xnews Home Area and a device configuration for a Remote Renderer device is 
present in the central Xmedia Server’s Device Manager.

Clicking the Remote Preview button sends the page or template being edited to the 
Remote Renderer device to be rendered. An image of the scene at the home key frame is 
returned to Xnews and appears in an Image Preview pop-up window.

The Image Preview window displays the scene rendered over a checkerboard background, 
which represents the transparency layer. If the resolution of the rendered image is larger 
than the Image Preview window, the image is scaled down to fit the entire window, while 
preserving its aspect ratio.

To render a preview image of a page on a Remote Renderer device:
1 Open a template or page in Xnews.
2 Click the Remote Preview button in the Xnews toolbar.

The progress is reported in the Xnews title bar and an image of the scene’s home key 
frame appears in the Image Preview pop-up window on the Xnews workstation.

Note: To change the scene’s home key frame, open the scene in 
Xstudio and edit the scene’s Home Key Frame property. See the 
Xstudio User Manual for more information.
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Saving and adding embedded pages to a story
Once you have completed all of your edits to the page, you can save and add the page to a 
story in the NRCS interface.

To save and add a newly created embedded page to a NRCS story:

With a story open in the NRCS and the page open in the Xnews Home Area:
• click the Save and insert page button  from the Xnews toolbar. The page closes and 

is saved to the story.

Or,
• Drag and drop the Drag bar from the Xnews interface into your NRCS’s story area.

To save any changes to an embedded page to a NRCS story:

With the page open in the Xnews Home Area, click the Save page button  from the 
Xnews toolbar. The page closes and is saved to the story.
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Unlike embedded pages, which only exist within a story/rundown, shared pages are 
distinct assets that are stored on the Xmedia Server and they can be used in many different 
playlists as a common item. See page 45 for more information about shared pages.

Creating a new shared page requires that Xnews be configured for Shared Pages mode. 
However, editing and/or adding shared pages to a NRCS story can be performed in either 
Embedded Pages or Shared Pages mode.

Fig. 6-1: Identifying shared pages

The following topics provide practical information and instructions for creating, editing and 
previewing shared pages using Xnews: 

• Creating a new shared page from a template, on page 66
• Opening an existing shared page, on page 67
• Editing and previewing a shared page, on page 68
• Saving shared pages to the Xmedia Server, on page 68
• Adding shared pages to a story, on page 69

This icon indicates

Shared pages are stored
on the Xmedia Server

that the open page
is a shared page
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Creating a new shared page from a template
Since pages are based on templates, you must first open the desired template to create a 
page from it. You can then edit the template’s replaceable fields (i.e. text, images, clips...etc.) 
and save it as a new shared page.

To create a new page from a template:
1 Display the available templates in the Asset Gallery by clicking the desired Templates 

category in the Asset Browser.
If a page is already open, click the Create new button  in the toolbar. This will close 
the open page, and then display the templates in the category that was last selected.
When the new page opens, the Asset Browser disappears. To display it again, click the 
orange gripper bar.

2 Double-click the template in the Asset Gallery from which you would like your page 
based. 
A new page is created based on the template and is opened for editing. The status bar 
indicates that the page has not yet been named and saved, and identifies the template 
on which it is based.

3 Modify the page’s replacable fields as required (see Saving shared pages to the Xmedia 
Server, on page 68 and Replacing an image, cel animation or a clip on a page, on 
page 53).

4 Set the page’s Offset and Duration settings that are displayed in the Status bar. See 
Displaying a listing of Work Orders or Jobs, on page 32.

5 To save the page:
a Click the Save page button  in the toolbar. 

The Save Page window appears, unless QuietMode is enabled. If QuietMode is 
enabled, then the page is automatically named (see page 8).

b Specify the following information on the Save Page window:
• Name - The name that you want to give to the new page.

• Recall ID - A code (usually numeric) you can assign to the page.

• Author - The name of the person who authored the page.

• Description - A description of the page.

• Available Categories - The categories in which you would like to 
store and make the page available.

c Click OK to save, or the Cancel button to close the window and returned to the 
unsaved page.

Note: If the Save Page button  is disabled in the toolbar, the Allow 
Creation of Server Pages setting has been disabled. See Preferences 
settings, on page 14 for information on how to enable this setting and 
enable the Save Page button.
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Opening an existing shared page
All of the previously created shared pages are centrally archived on the Xmedia Server. 
Using the Asset Browser and Asset Gallery in the Xnews interface, you can navigate to and 
open an existing page. 

Finding and opening an existing page using the Asset Browser and Asset Gallery:
1 With the Asset Browser open, navigate through the Pages root category by expanding 

the subcategories until the desired page appears or is listed in the Asset Gallery.

Fig. 6-2: Navigate through the Asset Browser and Asset Gallery to find an existing page

2 Once you have located the exact page that you want to open, either:
• Double-click the page’s proxy or name in the Asset Gallery.

Or,
• Right-click on the page’s proxy or name in the Asset Gallery and select the Open 

command.
The Asset Browser and the Asset Gallery both close and the page opens in the Home 
Area.

Note: You can also open a shared page that is listed in a NRCS story by 
double-clicking the page’s MOS entry in the story.

Note: The Asset Gallery can either list the pages in Detail View or as 
thumbnail graphics using the Proxy View. Use the Change the View 
button  to toggle between the two views.

Note: Since the Xmedia Server archives all shared pages, navigating 
and identifying a specific page using the Asset Browser might not be 
the most effective, especially if you are not familiar with the 
categorization logic. Another method for finding or sorting pages 
based on common themes or characteristics is to use the Search Tool. 
See Searching for assets on the Xmedia Server, on page 34.
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Editing and previewing a shared page
The procedures for editing and previewing pages are the same whether you are working 
with a shared or embedded page. Therefore, we ask that you refer to the following topics 
for instructions on how to edit and preview a shared page:

• Changing a template’s editable fields, on page 51
• Replacing an image, cel animation or a clip on a page, on page 53
• Using the Image Editor to edit a page’s image and create a new image asset, on page 54
• Previewing the on-air look of a page locally, on page 61
• Creating a Remote Preview of a page, on page 62

Saving shared pages to the Xmedia Server
You must save the page to conserve any changes that were made to the page or to archive 
the shared page in a category on the Xmedia Server.

The Xnews toolbar features three (3) buttons that can be used to save the shared page. The 
Save page button  is used to simply save the page to a category on the Xmedia Server. 
The Save and insert page button  not only saves the page to the Xmedia Server, it also 
inserts it into the story that is currently open in the NRCS interface. The Save and Close 
page button  indicates that the page being edited is part of, and will be saved to, the 
rundown.

To save a shared page:
1 With the page open in the Home Area:

• Click the Save page button  in the toolbar to just save the page to a category on 
the Xmedia Server. 
The Save Page window appears.

Or,
• Click the Save and insert page button  in the toolbar to save the page to a 

category on the Xmedia Server and insert it into the story that is currently open in 
the NRCS interface. 
The Save Page window appears.

Or,

Note: Not all fields on a template are designed to be editable. Whether 
or not a field is to be editable is determined by the creator of the 
template in Xstudio by enabling the field’s (asset’s) Allow Edit 
property. Therefore, if you select a field and you are unable to edit it, 
it most likely has been intentionally protected to enforce editorial 
standards.

Note: If the Save Page button  is disabled in the toolbar, the Allow 
Creation of Server Pages setting has been disabled. See Preferences 
settings, on page 14 for information on how to enable this setting and 
enable the Save Page button.
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• Click the Save and Close page button  in the toolbar to save any edits make to 
the page to the existing rundown and Xmedia Server.

2 Specify the following information on the Save Page window:
• Name - The name that you want to give to the new page.
• Recall ID - A code (usually numeric) you can assign to the page.
• Author - The name of the person who authored the page.
• Description - A description of the page.
• Available Categories - The categories in which you would like to store and make 

the page available.
3 Click OK to save, or the Cancel button to close the window and return to the unsaved 

page.

Adding shared pages to a story
Once you have completed all of your edits to the page, you can save and add the page to a 
story in the NRCS interface.

To save and add a new or existing shared page to a NRCS story:

With the page open in the Xnews Home Area:
• Click the Save and insert page button  from the Xnews toolbar. The page closes and 

is saved to the story.

Or,
• While holding down the Shift key, drag and drop the Drag bar from the Xnews 

interface into your NRCS’s story area.

Fig. 6-3: Adding a shared page to a story by dragging it from Xnews

Note: If the Save Page window does not appear and it appears that the 
page was saved automatically, then Xnews might have its 
QuietMode2 setting enable. See Configuring the xnews.ini file, on 
page 8 for more information.
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Acquiring images from the AP Graphics 
Bank
The Associated Press (AP) Graphics Bank is a breaking news and archive image service that 
offers an extensive selection of images for on-air broadcasters. Xnews provides integrated 
access to the AP Graphics Bank allowing you to search for suitable images and incorporate 
these images into Pages. 

The following sections provide information and instructions for setting up and using Xnews 
to search, preview and purchase images from the AP Graphics Bank:

• Enabling AP Graphics Bank integration on the Xmedia Server, on page 72
• Searching the AP Graphics Bank for images, on page 73
• Adding AP Graphics Bank preview images to a Page, on page 74
• Purchasing AP Graphics Bank images, on page 75

Note: The Work Order management system also benefits from the AP 
Graphics Bank integration by allowing you to fulfill jobs using images 
purchased from the AP Graphics Bank. See Creating and using Work 
Orders, on page 35 for information and instructions specific to using 
the AP Graphics Bank for Work Orders.
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Enabling AP Graphics Bank integration on the Xmedia Server
A prerequisite to using the AP Graphics Bank in Xnews is enabling and configuring specific 
settings on the Xmedia Server Control Panel’s Graphics Bank page. In fact, the AP Graphics 
Bank toolbar buttons and functionality are not displayed or active in Xnews unless these 
settings are configured.

Please refer to “Enabling AP Graphics Bank components” in the Xmedia Server Configuration 
Guide for instructions on enabling and configuring the settings on the Graphics Bank page.

Fig. 7-1: Required settings for using the AP Graphics Bank in Xnews
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Searching the AP Graphics Bank for images
Xnews provides integrated access to the AP Graphics Bank allowing you to search for 
suitable images and incorporate these images into Pages that can be previewed and/or 
played out to air. 

The search results are displayed as tiles in the main pane. Each tile consists of:
• A thumbnail of the image
• The image title
• The event date
• The dimensions of the full resolution image
• Possibly one of the following icons in the lower-right corner. Hovering the mouse over 

the icon displays usage and/or pricing information:

Right-clicking on the image’s tile exposes the Show Details... command, which allows you 
to view a larger version of the image in a pop-up window along with the following 
information:

• AP identification number for the image
• Title
• Description
• Event Date
• Dimensions
• Editorial Notes, Usage Terms, Pricing Information and/or Restrictions (see table above)

To search for images in the AP Graphics Bank:
1 Click the Search AP Graphics Bank  button in the Xnews toolbar.

The AP Graphics Bank: Search window appears.
2 Enter a search query by typing a keyword or boolean string in the text box.
3 Click the search  button or press Enter to launch the search.
4 Optional: If your search query returns a large amount of results, you may use the Sort 

setting’s drop-down list to reorder the results. Choose from:
• latest and most relevant
• latest
• most relevant
• oldest and most relevant

No icon There are no usage or pricing information associated with the image.

Information
An editorial note and/or usage terms informs you of how and/or in 
what context the image may be used. 

Pricing
There is additional pricing information associated with the image. 
This may describe extra charges that apply or identify the relevant 
PhotoChoice tier.

Prohibited
Informs you that the image may not be downloaded because it is not 
included your AP plan.
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5 Optional: To view details for a particular image, right-click on the image’s tile and select 
Show Details... 

6 Once you have found an image that you want to use, a preview version of the image 
can be dragged into a Page open in Xnews. See Adding AP Graphics Bank preview 
images to a Page, on page 74 for instructions.

Adding AP Graphics Bank preview images to a Page
Once you have searched and found an image in the AP Graphics Bank that you want to use, 
you can add a low resolution version of the image to a Page in Xnews. The Page can then be 
previewed on a device using the Preview feature of Xnews.

When an AP Graphics Bank image is downloaded for preview, a version of the image is 
saved as an asset in the GraphicsBank_Preview category on the Xmedia Server. The name 
of the image is formed by adding the prefix AP to the AP Graphics Bank identification 
number of the image, for example AP751929153890. 

The downloaded image is typically a smaller size than the full resolution indicated in the 
search result tile. 

To add an image from the AP Graphics Bank to a Page:
1 Open a Page in Xnews that contains images.
2 Click the Search AP Graphics Bank  button in the Xnews toolbar and search for an 

image. See Searching the AP Graphics Bank for images, on page 73 for instructions.
3 Drag the desired image’s tile from the AP Graphics Bank: Search window onto the 

Page in Xnews.
The image on the Page is immediately replaced with the preview image from the AP 
Graphics Bank.
A message is also displayed indicating that the Page contains unpurchased AP 
Graphics Bank images that must be purchased before being shown on air.

4 The Page can be previewed on a device using the Preview feature in Xnews.

Note: Downloading a preview image does not count as a purchase 
from the AP Graphics Bank. 

Note: An AP Graphics Bank preview image is typically not the same 
size as the full-resolution purchased image. It is recommended that 
Image objects in Templates and Scenes that will contain AP Graphics 
Bank images use a style of Keep Aspect to handle the different image 
sizes.

Note: When a Playlist Verification is performed in Xbuilder or Xplay, if 
an element in a playlist contains one or more AP Graphics Bank 
preview images that have not been purchased, the status of that 
element displays as Assets Awaiting Purchase until the images are 
purchased.
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Purchasing AP Graphics Bank images
Once an AP Graphics Bank image has been added to a Page, you may purchase the full 
resolution version of the image. As part of the purchase operation, you may also set 
properties for the image, including specifying a category where the image will reside on 
the Xmedia Server. 

To purchase images from the AP Graphics Bank:
1 Open a Page in Xnews that contains at least one unpurchased AP Graphics Bank image.
2 Click the Purchase Graphics Bank Images  button in the Xnews toolbar.

The AP Graphics Bank: Purchase Images window appears and displays the AP 
Graphics Bank images in the current Page that are awaiting purchase.

3 For each image that you want to purchase, select the image and set the following 
Image properties in the pane to the right of the image. 

Note: If more than one image is selected and all images have the same 
property value, the common property value is displayed. Otherwise 
the property field is blanked out. Changing a property value when 
multi-selected, applies the value to all selected images.

Name The name of the image asset. The default name is provided by the AP 
Graphics Bank, but you can edit it by typing directly in the Name field.
If more than one image is selected, the Name field is disabled. 
To quickly set the names of multiple images, click the first image to 
select it and type in new a name. Press the down arrow key to select the 
next image and then type in a new name.

Expiry Date The expiry date of the image asset specifies the date when the image is 
no longer needed and will be removed from the Xmedia Server and all 
devices to which it was published.
Choose None to indicate no expiry date, or select an expiry date from the 
calendar control.

Publish Lifespan The number of days that an image is kept on a device to which it has 
been published before it is no longer needed on the device and will be 
removed. 
A value of 0 indicates that the image should be kept indefinitely.

Categories By default, purchased images are automatically moved from the 
GraphicsBank_Preview category on the Xmedia Server to the 
GraphicsBank_Purchase category. 
If you prefer to store the image immediately in another category, you 
may use the tree view in the Categories pane to select the categories in 
which you want the image to reside.
You may also add a new category to the tree by selecting a category in 
the tree and clicking the Add Category button. The new subcategory is 
added as a child of the selected category. Type a new name for the 
subcategory. The new category is checked and ready to receive the 
image asset.
Click on the Refresh button to update the category tree from the MXS.
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4 For images that are listed that you do not wish to purchase, click the X button to 
remove them from the list. To restore all removed images, click the Restore button.

5 When all image properties have been entered, click on the Purchase button to execute 
a purchase of the images in the list. 
Each image is updated with the high resolution version of the image from the AP 
Graphics bank and its properties are updated. After the purchase is complete the 
purchase status is displayed next to each image. 

6 Once the purchases are successful, click Cancel to close the window.
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In/Out settings
Video clip assets (Clips) that are stored on the Xmedia Server can be inserted directly into a 
story. Before adding a clip to a story, however, you may want to use the Mark In/Out Editor 
to trim the clip. You can do this by setting the clip’s Mark In and Mark Out values, without 
modifying the original clip file. 

When Xnews is used in an ENPS system, the Mark In/Out Editor is a standalone window that 
provides the additional functionality of previewing the clips playout. When Xnews is 
integrated within an iNEWS system, the Mark In/Out Editor is embedded in the Xnews 
interface and it does not allow you to preview the clip’s playout.

The following sections describe how to use the Xnews Mark In/Out Editor:
• Locating and opening a clip asset using the Xnews Asset Browser, on page 78
• Preview and editing the clip’s mark in/out settings, on page 79
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Locating and opening a clip asset using the Xnews Asset Browser
Video clip assets are stored on the Xmedia Server and therefore they can be opened during 
an Xnews session using the Asset Browser. All of the video clip assets are stored within the 
Clips root category in the Asset Browser. Navigate through the hierarchical subcategories 
and the clip’s proxy or name appears in the Asset Gallery.

Before you can open a clip in Xnews however, a story belonging to a rundown must be 
open in the newsroom computer system interface. If not, the clip will not open and an error 
appears in the lower part of the Xnews interface.

To locate and open a clip asset in using the Xnews Asset Browser in ENPS:
1 Open Xnews and expand the Asset Browser.
2 Select and navigate through the Clips root category until the desired clip is listed or 

displayed (proxy) in the Asset Gallery.
3 Double-click the clip asset in the Asset Gallery and the clip opens in the Mark In/Out 

Editor, which allows you to edit the clip’s start and stop times. The Mark In/Out Editor in 
an ENPS system also allows you to playout a preview of the clip.

If the Mark In/Out Editor is unable to load the clip asset, then the embedded Mark In/Out 
Editor appears and displays a proxy of the clip, as well as an error message. 

The video could not be loaded into the media player. [click for more 
details]

An error occurred obtaining the clip from the Xmedia Server. These errors 
sometimes occur when the user credentials are refused by the networking 
component of the server where the XMS resides. The full error message was 
"General access denied error". Please contact your network administrator 
and try again.
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Preview and editing the clip’s mark in/out settings
The Mark In/Out Editor allows you set a video clip asset’s Trim In (start point) and Trim Out 
(end point) without permanently changing the clip. You can also preview the clip’s playout 
when the Mark In/Out Editor is opened on an ENPS system.

The following sections provide more information:
• Overview of the standalone Mark In/Out Editor interface in ENPS, on page 80
• Overview of the embedded Mark In/Out Editor interface in iNEWS, on page 81
• Setting the Trim In and/or Trim Out points, on page 82
• Previewing the clip in the standalone Mark In/Out Editor, on page 83

Note: When opening a clip in ENPS, the Mark In/Out Editor opens as a 
standalone window. However, when a clip is opened in iNews, or 
when an error occurs when trying to load the clip in ENPS, the Mark 
In/Out Editor is embedded in within Xnews. 

Standalone Mark In/Out Editor with ENPS Embedded Mark In/Out Editor in iNEWS
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Overview of the standalone Mark In/Out Editor interface in ENPS
The following descriptions provide an overview of the features and components of the 
standalone Mark In/Out Editor that is used by Xnews in ENPS systems to set a clip’s trim 
values, as well as preview the playout of the clip.

Fig. 8-1: Use the Mark In/Out Editor to preview the clip and set the clip’s Trim In and Trim Out values

1 Clip name: The name of the video clip asset that has been opened appears at the top of 
the Mark In/Out Editor window.

2 Preview pane: It is often useful to preview the changes that you make before you 
commit to them. Therefore, using the Current Position slider you can preview the 
playout of a particular instance of the clip in the Preview pane. As well, you can use the 
transport controls to play back the clip including any edits that you have made using 
the Mark In/Out Editor.

3 Current position: The current time code position of the video that is being played out 
in the preview panel is indicated beside this heading. A thin yellow line also reports the 
current location along the video and audio tracks. Dragging the yellow line along the 
tracks allows you to preview and stop on specific frames within the clip. You can also 
use your keyboard’s left and right direction keys to move the yellow current position 
line with finer precision.

4 Clip Trim In: Dragging the Clip Trim In handle allows you to crop the beginning of the 
clip by setting a new location from where the clip will begin to play. The original clip 
asset remains unchanged, but the trim setting is implemented in the story when the 
Apply button is clicked.

5 From and To times: Displays the adjusted length of the clip after taking into 
consideration the new trim settings. The value displayed is in time code format. The 
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2. Preview Pane
3. Current Position
4. Clip Trim In
5. From & To Times
6. Transport Controls
7. Clip Trim Out
8. Duration
9. Apply & Cancel Buttons
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time reported in the From field is where the clip will start from, and the To field 
represents the point where the clip will stop playing. 

6 Transport controls: The transport controls allows you to preview the clip’s playout in 
the Mark In/Out Editor’s preview panel, including the effects of the trim settings. The 
controls consist of a Stop button, a Play button, and a Loop check box.

7 Clip Trim Out: Dragging the Clip Trim Out handle allows you to crop the ending of the 
clip by setting a new location where the clip will finish playing. The original clip asset 
remains unchanged, but the trim setting is implemented in the story when the Apply 
button is clicked. 

8 Duration: Displays the total amount of time the clip will take to play out taking into 
consideration the new trim settings. The value displayed is in time code format.

9 Apply and Cancel buttons: All adjustments to the clip’s trim settings are simulations in 
the Mark In/Out window until you click the Apply button. Once you click the Apply 
button, the trim settings are automatically applied to the clip’s entry in the story. click 
the Cancel button if you do not want to apply the changes from the Mark In/Out Editor 
to the clip in the story.

Overview of the embedded Mark In/Out Editor interface in iNEWS
The following descriptions provide an overview of the features and components of the 
embedded Mark In/Out Editor that is used by Xnews in iNEWS systems to set a clip’s trim 
values. 

Fig. 8-2: The Mark In/Out Editor is embedded in the Xnews interface for iNEWS systems

1 Clip name: The name of the video clip asset that has been opened appears at the top of 
the Mark In/Out Editor window.

2 Proxy Image: If available, a thumbnail image of a frame within the clip file is displayed 
to help visually identify the clip.

3 Clip Trim In: Dragging the Clip Trim In handle allows you to crop the beginning of the 
clip by setting a new location from where the clip will begin to play. The original clip 
asset remains unchanged, but the trim setting is applied to the clip in the story. You can 

Note: Unlike the standalone ENPS version, the embedded Mark In/Out 
Editor does not have the ability to preview the clip’s playout.
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also set the Trim In by placing the current position line (yellow line) on the desired 
frame, then right-click and choose the Set Trim In command.

4 From and To times: Displays the adjusted length of the clip after taking into 
consideration the new trim settings. The value displayed is in time code format. The 
time reported in the From field is where the clip will start from, and the To field 
represents the point where the clip will stop playing. 

5 Clip Trim Out: Dragging the Clip Trim Out handle allows you to crop the ending of the 
clip by setting a new location where the clip will finish playing. The original clip asset 
remains unchanged, but the trim setting is applied to the clip in the story. You can also 
set the Trim Out by placing the current position line (yellow line) on the desired frame, 
then right-click and choose the Set Trim Out command.

6 Duration: Displays the total amount of time the clip will take to play out taking into 
consideration the new trim settings. The value displayed is in time code format.

Setting the Trim In and/or Trim Out points
The Trim values allow you to crop the video so that the playout begins and ends at the 
specified locations, without changing the original clip asset. There are two (2) ways of 
setting the Mark In and Mark Out values for the clip:

• The Mark In/Out Editor has handles that you drag along the video track’s timeline to set 
the Trim In and Trim Out values. 

• Drag and drop the current position line (yellow line) to the desired frame, then right-
click and select either the Set Trim In command or Set Trim Out command.

Fig. 8-3: Trim settings are set by dragging the handles across the video track

When dragging the handles, be sure to use the various visual cues (Current position, 
From/To, Duration, and the preview panel) as references, for determining the precise 
frames for these settings.

Once you have moved the handles to the desired locations along the video track:
• If you are using the standalone Mark In/Out Editor in ENPS:

• You can preview the edited clip’s playout using the Editor’s Transport controls, 
current position line, and the Preview panel.

• If you are satisfied with the edits to the clip, then click the Apply button to insert 
the clip into the story. The clip will now contain the new Trim In and Trim Out 
settings.

• If you are using the embedded Mark In/Out Editor in iNEWS:
• If you are satisfied with the edits to the clip, the current Trim In and Trim Out 

settings are automatically applied to the clip in the story.

Trim Out 
handle

Trim In 
handle
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Previewing the clip in the standalone Mark In/Out Editor
It is often useful to preview the changes that you make before you commit to them. 
Therefore, using the Current Position slider you can preview the playout of a particular 
instance of the clip in the Preview pane. As well, you can use the transport controls to play 
back the clip including any edits that you have made using the Mark In/Out Editor.

To preview a particular frame of a clip in the Mark In/Out Editor Preview Panel:
1 Move your pointer to the current position line (thin yellow line) that appears on the 

video track.
As you hover over the current position line it changes into a directional line .

2 Drag the current position’s directional line along the video track. As you move the line, 
notice that the Current Position field above the video track updates and displays the 
exact frame location (timecode) of where the line is along the video track. As well, the 
preview panel updates and displays the video content at the location of the line.

3 When the Current Position field displays the desired time, or you see the desired frame 
in the preview panel, drop the line on the video track.
The content of the particular video frame where the line rests remains visible in the 
preview panel.

Fig. 8-4: Using the Current Position time and Line to preview the contents of a video frame

Note: The ability to preview the playout of clip assets is only available 
on the standalone Mark In/Out Editor used in ENPS. It is not available 
in the embedded version for iNEWS, however you can preview the clip 
using the software CG (see Enabling the Playout Preview setting, on 
page 8 and Creating a clip template in Xstudio for clip playout, on 
page 46).

Preview an exact frame
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Previewing the clip in the standalone Mark In/Out Editor
To preview the effects of the trim and fade settings by playing out the clip:
1 Make the desired changes to the trim and fade settings along the video and/or audio 

tracks.
2 Using the Current Position time display and the preview panel as a reference, drag and 

drop the Current Position line on the video track frame where you want the playout to 
begin from. 

3 click the Play button  in the Preview control below the video and audio tracks.
The clip begins to play immediately in the Preview panel.

Note: You can stop the playout in the Preview panel at any time by 
clicking the Stop button  in the Preview control. As well, you can set 
the playout to loop, or play repeatedly, by selecting the Loop check 
box  in the Preview control.
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Creating and working with stories and 
rundowns in ENPS
The topics in this chapter describe how to create a new rundown and then populate it with 
stories that contain graphic pages and clips.

• Creating a new rundown in ENPS, on page 86
• Creating a new story within a rundown in ENPS, on page 87
• Opening a story and adding graphics pages and/or clips in ENPS, on page 88
• Saving a story to a rundown in ENPS, on page 89

Related documentation
Please consult the Associated Press’ user documentation for precise and detailed 
information and instructions for using the ENPS newsroom computer system. 

• With ENPS open, clicking the F1 key brings up ENPS online help.
• ENPS - Basic User’s Guide version 4.5 by Associated Press Broadcast Technology

Note: Using a MOS Protocol based technique called MOS Redirection, 
Xmedia Servers work with the ENPS Newsroom Computer System 
(NRCS) to transfer stories and their associated media between Xmedia 
Servers within a single newsroom, or between multiple newsrooms 
and Xmedia Servers in different locations. See “Using MOS 
Redirection to transfer media between Xmedia Servers” in the Xmedia 
Server Configuration Guide for more information.
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Creating a new rundown in ENPS
If your system administrator has granted you the appropriate privileges, you can create a 
new Rundown in the ENPS system. 

To create a new rundown:
1 Open the ENPS application on the client workstation.
2 Select the System folder rover  > New > Rundown.

The Rundown Properties window appears.

Fig. 9-1: Creating a new rundown in ENPS

3 Enter the name of the new rundown in the Program field.
4 Scroll down the properties list and enable the MOS Control Active field by clicking the 

empty box to its right. A check mark appears when this property is enabled. This 
property links the rundown to the MOS Server (i.e. Xmedia Server).

Fig. 9-2: The Rundown Properties window

5 Click the Go button.
The rundown is created and exists on the ENPS system, but it does not exist on the 
Xmedia Server until an initial story is added to the rundown. See page 87 and page 88 
for instructions on how to add a story to a rundown and populate it in ENPS.
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Creating a new story within a rundown in ENPS
To create a new story within an existing rundown:

1 Open the ENPS application on the client workstation.
2 Open the rundown that the story will belong to:

a Select the System folder rover  > Show only > Rundown.
The rundowns stored within the System folder on the ENPS server are listed in the List 
Window.

Fig. 9-3: List all of the existing rundowns

b Double-click the rundown’s name and it opens in an Editing Window. If the 
rundown already contains stories, they are listed in the Rundown’s Editing Window.

Fig. 9-4: Opening a story from a rundown

3 Select the Rundown’s Editing Window’s rover  > Insert Row.
A new row is immediately added to the stories listed in the rundown. 

Fig. 9-5: Adding a new story to a rundown

4 Click in the new story’s Story Slug cell and type a name for the story.
5 Double-click the new story’s row to open the story in an Editing Window. This is where 

you will add graphics pages, clips, and or script text for the story (see Opening a story 
and adding graphics pages and/or clips in ENPS, on page 88).

Opened rundown
with stories

List of rundowns

in the Editing Window
in the List Window

New Story 
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Opening a story and adding graphics pages and/or clips in ENPS
To open a story and add graphics pages and/or clips:

1 Open the ENPS application on the client workstation.
2 Open the rundown that the story will belong to:

a Select the System folder rover  > Show only > Rundown.
The rundowns stored within the System folder on the ENPS server are listed in the List 
Window.

Fig. 9-6: Displaying a list of rundowns on the system

b Double-click the rundown’s name and the rundown opens in an Editing Window. 
If the rundown already contains stories, they are listed in the Rundown’s Editing 
Window. If it does not, then you will have to create a new story before proceeding.

Fig. 9-7: Listing the stories contained in the selected rundown

3 Double-click the story’s name in the rundown table and the story’s content is displayed 
in an Editing Window.

Fig. 9-8: Opening a story

Opened rundown
with stories

List of rundowns

in the Editing Window
in the List Window

Story’s name Story’s content
in the rundown
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4 Open Xnews.
5 Navigate through the Asset Browser to the template, page, or clip that you want to add 

to the story. 
6 Open the template, page or clip and make the appropriate edits:

For templates and pages:
a Open the page/template/clip by double-clicking on the template/page/clip’s 

heading/proxy in the Asset Gallery.
b Make any required changes to the page’s editable fields.

For clips:
c Open the clip by double-clicking on the clip’s heading/proxy in the Asset Gallery.
d Optional: Edit the mark in and/or mark out settings for the clip.

7 Either drag and drop the Xnews Drag bar to the story’s content window, or click the 
Save and Insert Page button .
The page/clip’s name now appears in the story as the clip is now embedded in the 
story.

Fig. 9-9: Drag and drop the Xnews Drag bar to the story’s content window

Saving a story to a rundown in ENPS
Once pages and/or clips have been added to a story, the story must be saved to the 
rundown. 

There are three ways in which you can save a story to a rundown in ENPS:
• Click the story’s rover  and select the Save command.

Or,
• Drag the story’s tab heading from the Editing window and drop it into the Rundown’s 

editing window.

Or,
• Click Ctrl+S on your keyboard.

Note: It is only upon saving the story to the rundown that the story’s 
content gets saved/updated on the Xmedia Server.
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Creating and working with stories in INEWS
Using Xnews within iNEWS allows you to easily create and edit stories from within a queue 
(rundown). 

Note that only system administrators and/or users with specific permissions can create 
queues in the iNEWS Directory Panel. 

The topics in this chapter describe how to add stories to an iNEWS queue (rundown), as well 
as how to use Xnews add pages and clips to the stories.

• Adding a new story to a rundown in iNEWS, on page 92
• Opening a story and adding a page or clip in iNEWS, on page 93
• Opening a page or clip that belongs to a story in iNEWS, on page 94

Related documentation
Please consult Avid’s iNEWS user documentation for precise and detailed information and 
instructions for using the iNEWS newsroom computer system. 

• Introduction to iNEWS Workstation v.2.0 (Training Manual) 
• iNEWS Newsroom Computer System Setup and Configuration Manual v.2.0 
• iNEWS Newsroom Computer System Operations and Troubleshooting Manual v.2.0 
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Adding a new story to a rundown in iNEWS
To add a story to a rundown (queue):

1 Open the queue in which you want the story to appear by double-clicking the queue’s 
heading in the Directory Panel. 
If stories already exist within the queue, they will be listed in the Queue Panel and Story 
Panel. However, if the queue does not already contain stories these panels will be 
empty.

Fig. 10-1: Adding a story to a rundown in iNEWS

2 Click anywhere within the Queue Panel and select the File>New story command from 
the iNEWS menu bar. 

3 A new story is inserted in the Queue Panel and Story Form.
4 Type the name of the story in the Slug column/field of either the Queue Panel or Story 

Form.

Queue in the Directory Panel

Stories in the Queue Panel and Story Form

Pages & Clips in the Story Panel
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Opening a story and adding a page or clip in iNEWS
To open a story and add a graphics page or clip using Xnews:

1 Open the story in which you want to add the page.
a Navigate through the Directory Panel to the queue folder that contains the desired 

story (e.g. NRCS-A>SHOW>VERTIGO).
b Open the queue by double-clicking the queue’s heading in the Directory Panel.

The stories belonging to the queue are listed in the Queue Panel.
c Select the slug name of the story that contains the page or clip that you want to 

open.
The pages and clip belonging to the story are listed in the Instruction Panel side of the 
Story Panel.

Fig. 10-2: Open the story upon which you want to add a page or clip

2 Launch Xnews by selecting Tools>Plugins>VertigoXmedia Xnews
3 Navigate through the Xnews Asset Browser and Asset Gallery to locate the template, 

page, or clip that you want to insert into the story.
4 Open the template, page or clip and make the appropriate edits:

For templates and pages:
a Open the page/template/clip by double-clicking on the template/page/clip’s 

heading/proxy in the Asset Gallery.
b Make any required changes to the page’s editable fields.

For clips:
c Open the clip by double-clicking on the clip’s heading/proxy in the Asset Gallery.
d Optional: Edit the mark in and/or mark out settings for the clip.

Queue in the Directory Panel

Stories in the Queue Panel

Pages & Clips in the Instruction Panel of the Story Panel
93



Creating and working with stories in INEWS
Opening a page or clip that belongs to a story in iNEWS
5 Drag and drop the Xnews Drag bar to either side of the Story Panel (Instruction Panel or 
Story Text Panel).
The page/clips’ name is added to the Instruction Panel and a pink asterisk is added to 
the Story Text Panel to represent the added page.

Opening a page or clip that belongs to a story in iNEWS
To open a page or clip that belongs to a story:

1 Open the story that contains the page or clip that you want to open.
a Navigate through the Directory Panel to the queue folder that contains the desired 

story (e.g. NRCS-A>SHOW>VERTIGO).
b Open the queue by double-clicking the queue’s heading in the Directory Panel.

The stories belonging to the queue are listed in the Queue Panel.
c Select the slug name of the story that contains the page or clip that you want to 

open.
The pages and clip belonging to the story are listed in the Instruction Panel side of the 
Story Panel.

2 Double-click the page’s or clip’s name in the Instruction Panel.
If Xnews was not already open in the iNEWS workspace, Xnews launches automatically. 
The page or clip appears in the Xnews home area.

3 Click the Apply button along the bottom of the iNEWS interface.

Story Text PanelInstruction Panel

Queue in the Directory Panel

Stories in the Queue Panel

Pages & Clips in the Instruction Panel of the Story Panel
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Playing out rundowns using Xplay
Xplay is the Vertigo Suite’s playout management software that allows you to control and 
playout the rundown that was created using Xnews and your newsroom computer system.

When pages and clips are saved to a rundown’s story, the rundown is saved on the Xmedia 
Server. Xplay is able to use the rundown as a playlist, which you can manually or 
automatically take the playlist to air.

While complete instructions for using Xplay are available in the Xplay User Manual, this 
chapter offers you an overview of the Xplay interface and offers you “quick start” 
instructions for using Xplay to control and playout the contents of a rundown to a device.

The topics in this chapter discuss:
• Overview of the Xplay interface, on page 96
• Opening a rundown in Xplay, on page 98
• Updating and reloading a rundown in Xplay, on page 98
• Verifying device connections in Xplay, on page 100
• Playing out a rundown in Xplay, on page 101

Note: The information and instructions in this chapter assume that 
Xplay has been properly installed, configured, licensed, and 
connected to the proper device(s). If any of these conditions is not 
met, please consult the Xplay User Manual before proceeding to read 
this chapter.
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Overview of the Xplay interface
To help familiarize yourself with the Xplay interface, we encourage you to take a close look 
at Figure 11-1 and Figure 11-2, as well as the following descriptions, which identify the 
Xplay’s main interface components and provides brief functional descriptions of each.

To open Xplay:
• Click Start>Programs>VertigoXmedia>Xplay Pro.

Fig. 11-1: Xplay set to Manual playout mode and On-Air Preview layout mode

Fig. 11-2: Xplay set to Automatic playout mode and Multi-Device layout mode

1 Main menus: Provides access to commands that execute most of Xplay’s functionality. 
• File menu - Contains commands for opening and editing playlists (rundowns), as 

well as to close the Xplay application.
• View menu - Contains commands for opening logs, as well as for exposing Xplay’s 

Asset Browser, Quick Recall field, and Search tool.
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• Actions menu - Contains commands for controlling the playlist and the playout of 
the playlist items, including Reload playlist, Cue, Take, and Clear commands.

• Tools menu - Contains commands for configuring Xplay’s settings, as well as 
configuration settings for the interaction of Xplay with playout devices and other 
services.

• Help menu - Contains a command for identifying the Vertigo Suite’s version and 
build number, as well as a command for installing Xplay’s required license.

2 Asset Browser: The Asset Browser, which is located within a collapsible panel, provides 
a tree view of assets stored on the Xmedia Server. You can use the Asset Browser to 
locate and load a rundown into Xplay.

3 Status bar: Displays the MOS Protocol logo indicating that the currently loaded playlist 
is a rundown that is written by a MOS application. The implication is that the newsroom 
system may save this rundown at anytime and eliminate any changes that you may 
have made. Xplay’s Save buttons are disabled when a rundown is loaded. The MOS logo 
is followed by the rundown’s name. Also displayed is the name/IP address and 
connection status of the Xmedia Server that Xplay is configured to connect to.

4 Playlist window: The workspace where an opened rundown is displayed as a playlist. 
Playlist items (story headings, pages, clips, comments...etc.) are organized in a 
sequential list that determines their playout order. See Playing out a rundown in Xplay, 
on page 101 for more information.

• The buttons along the top of the window are used for loading and managing 
playlists in this window. These buttons allow you to open a new playlist, as well as 
save, reload, looping... the playlist and its items.

• The Quick Recall field, which can be hidden/exposed using View>Quick Recall, 
allows you to enter a page or template’s Recall ID to perform various shortcuts. 

• Which buttons appear at the bottom of the Playlist window is determined by 
Xplay’s playout mode: Manual or Automatic.

• In Manual playout mode, the Cue and Take buttons allow you to control the 
timing of when the playlist items appear on air. 

• In Automatic playout mode, the Timer, Play, Pause, and Stop buttons allow 
you to playout the playlist using the timing specified in the playlist.

5 Device & Preview display panes: Xplay’s General settings (Tools>Settings) allow you 
to set the Layout setting to either Multi-Device or OnAir-Preview, which affects the 
appearance of Xplay’s display panes. The display panes allow you to see a visual 
representation of the playlist item that is either being cued or being currently being 
played out on a device.

• Multi-Device: When Xplay is configured to playout to multiple devices, a display 
pane appears for each of the devices that Xplay is connected or outputting to. Each 
device’s display pane has indicators that inform of the device’s connection status, 
as well as override buttons for controlling the playout of the playlist items on that 
device (e.g. Cue, Take Clear). This allows you to take selected playlist items to air on 
the channel of your choice.

• OnAir-Preview: This mode is commonly used when Xplay is only connected to a 
single device with a single keyer. The upper display pane shows the playlist item 
that is currently on air and the lower pane previews the item that has been cued as 
next-to-air.
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Opening a rundown in Xplay
To open a rundown in Xplay:

1 Select the File>Open Playlist command. Or, select the Open Existing Playlist button 
.

The Open Playlist window appears.
2 Navigate through the Rundowns root category, until the desired rundown is 

listed/displayed.
3 Double-click the desired Rundown’s name/proxy.

The rundown opens as a playlist in Xplay’s Playlist Window.

Updating and reloading a rundown in Xplay
If a rundown has been open in Xplay for a while, you may need to reload it to ensure that it’s 
still up-to-date. For example, additional items may have been appended to the rundown by 
a user at another workstation while the rundown was also open at your workstation.

How you reload and whether it’s necessary at all depends on how Xplay has been 
configured. There are three possible scenarios:

• The Playlist update interval setting has not been activated. In this case, Xplay will not 
be checking for updates. For changes made at remote workstations to take effect, the 
rundown must be manually reloaded. See Manually reloading a rundown in Xplay, on 
page 99.

• The Playlist update interval setting has been activated, but not the Auto reload 
playlists setting (see Configuring Xplay’s update and reload settings, on page 99). This 
means that Xplay will periodically check the Xmedia Server for updated versions of the 
rundown, but it will not automatically reload the new version for you. Instead, the 
Reload Playlist button  will turn orange to indicate that a new version has been 
detected. Click the button to reload.

• Both the Playlist update interval and Auto reload playlists settings have been 
activated (see Configuring Xplay’s update and reload settings, on page 99). Xplay will 

Note: You can also open a rundown using the Xplay’s Asset Browser. If 
the Asset Browser is not already displayed, select View>Asset Browser. 
Navigate through the Rundowns root category until you find the 
rundown’s name in the Asset Browser. Double-click the rundown’s 
name and the rundown is loaded as a playlist in Xplay’s Playlist 
Window.

Note: Although you can edit other types of playlists using Xplay, 
rundowns can only be edited in Xnews and the newsroom computer 
system. In a newsroom environment, Xplay is only used for controlling 
and playing out the rundown.
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check the Xmedia Server for an updated version of the current rundown and it will 
automatically reload it when it finds a newer version.

Configuring Xplay’s update and reload settings
The Auto reload playlist and Playlist update interval settings work together to determine 
when and how frequently Xplay will take the initiative to reload the rundown. See Updating 
and reloading a rundown in Xplay, on page 98 for an overview discussion of this topic.

To configure Xplay’s playlist reload and update settings:
1 In Xplay, select Tools>Settings>Playout.

The Settings window appears and displays the Playout settings.
2 Set the Playlist update interval setting.

Enter a number to represent the number of seconds between each time (continuous) 
that Xplay checks to see if the current playlist has changed in the Xmedia Server. 
Entering 0 means that Xplay will never check for updated versions. The action taken 
when a playlist has changed is determined by the Auto reload playlists setting.

3 Set the Auto reload playlists setting.
Selecting the check box means that when an updated version of the currently active 
playlist is found, it will automatically be loaded. When the check box is deselected, the 
Reload Playlist button  will turn orange to alert the user to the new version so they 
can reload it manually.

4 click OK to close the Settings window.

Manually reloading a rundown in Xplay
When the Playlist update interval setting has not been activated, Xplay will not check the 
Xmedia Server for updates to its currently opened rundown. For any changes that were 
made to the rundown to take effect, the rundown must be manually reloaded in Xplay 
using the Reload Playlist button  in the Playlist window’s toolbar. 

Note: The pages currently on air remain on air even if they have been 
moved to new locations in the rundown, or have been removed 
altogether.
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Verifying device connections in Xplay
Before beginning playout, make sure that Xplay is connected to the playout device(s). A 
device’s connection status is indicated in Xplay by the LED next to the device’s name in the 
display panes.

Fig. 11-3: Whether or not Xplay is connect to a device is indicated by the LED’s color (Green or Red)

If Xplay is in Manual mode and the rundown that you will be playing out contains clip 
assets that were inserted directly into the story, you must also verify that the clip template 
and clip object have been specified on the device’s configuration. See page 46 for 
instructions on verify and/or adding the clip template data to the device configuration.

To connect Xplay to one or more devices:

If the LED next to the device name is red, double-click it. The LED turns green if a 
connection to the device is established. If the LED remains red, it means one of the 
following:

• The information describing the device has been entered incorrectly.
• The desired device is down.
• The network connection has been lost.

If no names or LEDs appear within the display pane, it means none have been defined 
and/or assigned. If this is the case, refer to the instructions in the Xplay User Manual on how 
to set up your devices. If desired, you can disconnect from all devices and run your playlist 
in Xplay to ensure that all page information is correct. 

To disconnect Xplay from one or more devices:
1 From the Tools menu select Devices>Configure Devices.
2 Select the active device for the required view and then click the left-pointing arrow. 

Xplay is now disconnected from the output device.

Note: Adding, removing, and configuring devices is performed in the 
Device Manager (Tools>Device Manager). Instructions for using the 
Device Manager are provided in the Xplay User Manual.

Note: If you want to temporarily disconnect a device from Xplay, 
without removing the device from the display pane; simply right-click 
on the device’s LED and select the Disconnect command (the green 
LED turns red). Double-click the device’s LED to reconnect.

Green = Connected
Red = Disconnected
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Playing out a rundown in Xplay
The most common way to control the playout of a rundown in Xplay is to advance through 
the items in their listed order. Xplay offers two (2) sequential playout modes:

• Automatic playout mode, on page 102
• Manual playout mode, on page 103

To verify Xplay’s current playout mode, simply look at the Playlist window portion of the 
Xplay interface:

• If the lower portion of the window contains a Cue and Take button, then it is in Manual 
playout mode.

• If the lower portion of the window contains a clock and Play, Pause, and Stop buttons, 
then it is in Automatic playout mode.

Fig. 11-4: Xplay has two modes for playing out rundowns in sequential order: Automatic and Manual

To change Xplay’s Playout Mode setting:
1 Select the Tools>Settings command.

The Settings window appears.
2 Select the Xplay>Playout categories from the tree-structure in the Settings window.
3 In the Initial playout mode setting, choose either Manual or Auto from the drop-down 

list.
4 Click OK.
5 Close and restart Xplay for the changes to take effect.

Automatic playout mode Manual playout mode
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Automatic playout mode
Automatic playout mode allows you to output the playlist’s content sequentially according 
to the time specifications set out in the Offset column.

Fig. 11-5: Playing out a rundown in automatic mode

To play out a playlist in Auto mode:
1 Open the rundown in Xplay.
2 Verify that Xplay is in Automatic playout mode.
3 Verify that Xplay is connected to the desired playout device(s).
4 Select the desired starting point for the playout by double-clicking on the playlist item 

that will be first to go to air.
The playlist item is cued is displayed in the Preview pane on the right-side.

5 Use the following buttons to control the playout of the rundown:

Note: Once the playout of the rundown has begun in Automatic 
mode, updates cannot be made to the rundown until the playout has 
stopped.

Click the Play button to start the playout of the playlist from the currently 
cued playlist item. If no item is currently cued, then playout will be begin 
with the first item in the playlist. As the playlist is being played out, the 
clock counts down the time until the next playlist item is brought to air 
and the playlist item is displayed on the device’s display pane.

Click the Pause button to temporarily halt the playlist’s playout. Clicking 
the Pause button again resumes the playlist from where you paused.

Click the Stop button to terminate the playlist’s playout. Clicking the Play 
button after the playlist has been stopped restarts the playlist’s playout 
from at the cued playlist item. 

Note: Select the Actions>Clear All command from the Xplay menu to 
clear the playlist (remove the current cued and/or on air status). 
Similarly, you can clear the Preview and device panes by clicking the 
Clear / Uncue  override buttons above each of the display panes.
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Manual playout mode
Manual playout mode allows you to control the pace at which the rundown’s items are 
taken to air by clicking the Take button. Therefore, rather than using the playlist items’ 
Offset settings, you can click the Take button to bring the most recently cued item to air on 
the device/keyer, while the next item in the rundown is cued.

Fig. 11-6: Playing out a rundown in Manual playout mode

To play out a playlist in Manual mode:
1 Open the rundown in Xplay.
2 Verify that Xplay is in Manual playout mode.
3 Verify that Xplay is connected to the desired playout device(s).
4 Select the desired starting point for the playout. Either double-clicking on the playlist 

item, or click the Cue button  to indicate that it is the next item to go to air.
The playlist item is cued is displayed in the Preview pane on the right-side.

5 Select the Take button  to bring the cued item to air on the output device(s).
The next item in the playlist is automatically cued up.

Note: Select the Actions>Clear All command from the Xplay menu to 
clear the device (remove the current cued items and/or on air status). 
Similarly, you can clear the Preview and device panes by clicking the 
Clear / Uncue  override buttons above each of the display panes.
103



Playing out rundowns using Xplay
Manual playout mode
104



Contact Us
Grass Valley Technical Support
For technical assistance, contact our international support center, at 
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s Web site (www.grassvalley.com).

An online form for e-mail contact is also available from the Web site.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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